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Before You Begin  
This section provides you with safety information, technical support 
information, and sources for additional product information. 

Safety Summary 
Your safety is extremely important. Read and follow all warnings and 
cautions in this document before handling and operating Intermec 
equipment. You can be seriously injured, and equipment and data can be 
damaged if you do not follow the safety warnings and cautions. 

Do not repair or adjust alone 
Do not repair or adjust energized equipment alone under any 
circumstances. Someone capable of providing first aid must always be 
present for your safety. 

First aid 
Always obtain first aid or medical attention immediately after an injury. 
Never neglect an injury, no matter how slight it seems. 

Resuscitation 
Begin resuscitation immediately if someone is injured and stops breathing. 
Any delay could result in death. To work on or near high voltage, you 
should be familiar with approved industrial first aid methods. 

Energized equipment 
Never work on energized equipment unless authorized by a responsible 
authority. Energized electrical equipment is dangerous. Electrical shock 
from energized equipment can cause death. If you must perform 
authorized emergency work on energized equipment, be sure that you 
comply strictly with approved safety regulations. 
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Safety Icons  
This section explains how to identify and understand dangers, warnings, 
cautions, and notes that are in this document. You may also see icons that 
tell you when to follow ESD procedures and when to take special 
precautions for handling optical parts. 

 

A warning alerts you of an operating procedure, practice, condition, 
or statement that must be strictly observed to avoid death or serious 
injury to the persons working on the equipment. 

Avertissement: Un avertissement vous avertit d’une procédure de 
fonctionnement, d’une méthode, d’un état ou d’un rapport qui doit 
être strictement respecté pour éviter l’occurrence de mort ou de 
blessures graves aux personnes manupulant l’équipement. 

 

A caution alerts you to an operating procedure, practice, condition, or 
statement that must be strictly observed to prevent equipment damage 
or destruction, or corruption or loss of data. 

Attention: Une précaution vous avertit d’une procédure de 
fonctionnement, d’une méthode, d’un état ou d’un rapport qui doit 
être strictement respecté pour empêcher l’endommagement ou la 
destruction de l’équipement, ou l’altération ou la perte de données. 

 
Note: Notes either provide extra information about a topic or contain 
special instructions for handling a particular condition or set of 
circumstances. 

Global Services and Support 

Warranty Information 
To understand the warranty for your Intermec product, visit the Intermec 
web site at http://www.intermec.com and click Service & Support. The 
Intermec Global Sales & Service page appears. From the Service & 
Support menu, move your pointer over Support, and then click 
Warranty. 

Disclaimer of warranties: The sample code included in this document is 
presented for reference only. The code does not necessarily represent 
complete, tested programs. The code is provided “as is with all faults.” All 
warranties are expressly disclaimed, including the implied warranties of 
merchantability and fitness for a particular purpose. 
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Web Support 
Visit the Intermec web site at http://www.intermec.com to download our 
current documents in PDF format. To order printed versions of the 
Intermec manuals, contact your local Intermec representative or 
distributor.  

Visit the Intermec technical knowledge base (Knowledge Central) at 
http://intermec.custhelp.com to review technical information or to request 
technical support for your Intermec product. 

Telephone Support 
These services are available from Intermec Technologies Corporation. 

 
 
Service 

 
 
Description 

In the U.S.A. and Canada 
call 1-800-755-5505 
and choose this option 

Factory Repair and 
On-site Repair 

Request a return authorization 
number for authorized service 
center repair, or request an on-
site repair technician. 

1 

Technical Support Get technical support on your 
Intermec product. 

2 

Service Contract 
Status 

Inquire about an existing 
contract, renew a contract, or 
ask invoicing questions. 

3 

Schedule Site Surveys 
or Installations 

Schedule a site survey, or 
request a product or system 
installation. 

4 

Ordering Products Talk to sales administration, 
place an order, or check the 
status of your order. 

5 

   

Outside the U.S.A. and Canada, contact your local Intermec 
representative. To search for your local representative, from the Intermec 
web site, click Contact. 

Who Should Read This Document? 
The guide provides you with information about the features of the Data 
Collection Browser (dcBrowser) client, and how to install, configure, 
operate, maintain, and troubleshoot the dcBrowser client.  

Before you install and configure the dcBrowser client, you should be 
familiar with your network and general networking terms, such as IP 
address.  
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Related Documents 
The Intermec web site at http://www.intermec.com contains our current 
documents that you can download in PDF format.  

To order printed versions of the Intermec manuals, contact your local 
Intermec representative or distributor. 
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Getting Started 

 

This chapter describes the Data Collection Browser (dcBrowser) and 
explains the environments that you must set up in order to run the Data 
Collection Browser. This chapter covers these topics: 

• Learning about dcBrowser 

• What is new in version 2.4? 

• About the environments 

 

1 
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Learning About the Data Collection Browser 
The Intermec Data Collection Browser™ (dcBrowser™) provides a 
HyperText Markup Language (HTML) application development 
environment for Intermec data collection devices. Use dcBrowser to run 
HTML applications in your data collection network and to send the 
information to your enterprise information system.  

Using the dcBrowser has many advantages: 

• You can simplify application development by using state-of-the-art 
tools.  

• You can leverage access to legacy information through existing HTML 
applications for your PC. You only need to develop new web pages for 
the devices. 

• You can use the same application for all your data collection devices, 
since dcBrowser can reformat web pages for different screen sizes. 

• You have reduced support costs. You can easily upgrade your 
applications, since they reside in a central location on the web server. 

• You reduce project risk by using web-based middleware servers. In other 
words, you can deploy a data collection network and retain the 
flexibility to change the back-end system. 

• You use less bandwidth in your data collection network because the data 
collection devices only provide the user interface, while the web server 
provides all of the computational power.  

You create applications using standard web technology software tools. 
These applications reside on a web server. The dcBrowser gateway converts 
standard web (HTML v3.2 syntax) pages received from web servers into 
condensed ASCII and sends them to the dcBrowser client running on the 
device. Refer to the illustration and explanation on the next page. 
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Understanding dcBrowser 

1 A device running the dcBrowser client is turned on, and it requests a 
web page.  

2 The dcBrowser gateway identifies the web home page for this device. 
The dcBrowser gateway requests this home page from the web server.  

3 The web server sends the requested home page to the dcBrowser 
gateway. 

4 The dcBrowser gateway interprets the web home page, creates a 
compressed data format, and sends it to the device. 

5 Information from the device is sent to the dcBrowser gateway, which 
takes the compressed data format, converts it to HTML, and sends it to 
the web server. The web server may send other web pages to the device 
based on information that it receives. 
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What Is New in Version 2.4? 
With dcBrowser v2.4, you have the following new features: 

• The dcBrowser clients on Windows CE products are compatible with 
iLauncher. You can now use iLauncher to switch between the 
dcBrowser client and other applications. Also, the dcBrowser client 
maintains and cooperates with iLauncher’s system lockout feature, 
which keeps the user from accessing the product Start menu and other 
menus and features. 

• On the 700 Series Mobile Computer and the CV60 Vehicle Mount 
Computer, the IMDCB.INI file is saved to SDRAM card (700) or PC 
card (CV60) to ensure that the dcBrowser client configuration is 
preserved during a cold boot.  

• On the CK30, the configuration for the dcBrowser client is cold boot 
persistent through the registry. 

• On the 700, you can set a user interface lockdown feature that protects 
the 700 from unauthorized use of the Start menu and removes the 
caption bar allowing two extra text lines on the screen. For help setting 
this feature, see Chapter 7, “700 Series Mobile Computer.” 

• Currently on the 700, the dcBrowser client hides the system tray button 
for the virtual keyboard. With v2.4, you can configure the IMDCB.INI 
file to display the system tray button for the keyboard while the 
dcBrowser client is on and to allow for a custom virtual keyboard that 
provides function keys F1 through F24. For help setting this feature, see 
Chapter 7, “700 Series Mobile Computer.” 

• On the 700, you can configure how long the dcBrowser client will try to 
connect to the server. For help setting this feature, see Chapter 7, “700 
Series Mobile Computer.” 

• The CK30 Handheld Computer and CV60 Vehicle Mount Computer 
are now supported. 
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About the Environments 
You should understand the following three environments. 

dcBrowser Environments 

Environment Description 

Development Use the development environment to create the HTML application 
for your data collection devices. Your application development tool 
must support the HTML v3.2 syntax. You should test and debug 
your application in the development environment before you use the 
test environment. For help, see Chapter 2, “Developing and Testing 
Your Application.” 

Test Use the test environment to simulate running the HTML 
application. Copy your application and web pages to a web server, 
and then load a web browser and the simulator on your PC. Using 
the web server, the web browser, and the simulator, you can run your 
application. The simulator contains a local dcBrowser gateway that 
runs on your PC, and it simulates the dcBrowser gateway on the 
DCS 30X, G4X00, or the software-only dcBrowser gateway. The 
simulator also simulates the device screens so you can enter data and 
see how the application responds. For help, see Chapter 2, 
“Developing and Testing Your Application.” 

Runtime Use the runtime environment to run the HTML application in your 
data collection network. If necessary, load the dcBrowser client on 
your devices, and then copy your application and web pages to a web 
server. You configure the dcBrowser gateway on the DCS 30X or 
G4X00. When you turn on your devices, they request a web page 
from the web server. For help, see the user’s manual that ships with 
your DCS 30X or G4X00 or the online help for the dcBrowser 
gateway software. 
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Developing and Testing Your 
Application 

 

This chapter provides a list of the HTML features that are supported, the 
features that are not supported, and additional information about some of 
the tag attributes of dcBrowser. It also provides a summary of the HTML 
tags and how dcBrowser supports them and a sample HTML file. This 
chapter covers these topics: 

• About the development environment 

• Supported HTML features 

• Unsupported HTML features 

• Summary of HTML 3.2 tags 

• Special HTML tags 

• Example web page and HTML code 

• Advanced features 

• About the test/software only gateway environment 

• Setting up the test/software only gateway environment 

• Configuring the test/software only gateway environment 

• Testing your application 

• Setting up the runtime environment 

2 
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About the Development Environment 
dcBrowser provides a runtime environment for data collection devices. For 
more information about the development environment, see Chapter 1, 
“Getting Started.”  

 

Note: Compile your CGI scripts for whatever environment your web 
server uses. If you want to put your CGI scripts and your web pages on the 
DCS 30X, you must compile your CGI scripts for OS/2. 

You can put your CGI executables into the D:\USERDATA\CGI-BIN 
directory, and you can put your web pages into the 
D:\USERDATA\HTDOCS directory on the DCS 30X. Once you have 
moved your web pages, you must add /user to the URL of the web page. 
For example, if you moved RFSIGN.HTM to the 
D:\USERDATA\HTDOCS directory, the URL would be /user/rfsign.htm. 
Also, if you wanted RFSIGN.HTM to use a CGI executable in the 
D:\USERDATA\CGI-BIN directory, you would need to change the 
following code: 

<FORM METHOD=POST ACTION=“/cgi-bin/cgi.exe”> 

to 

<FORM METHOD=POST ACTION=“/user-cgi/cgi.exe”> 

You would need to make similar changes in CGI.C to allow for the correct 
virtual directories. 

Supported HTML Features 
dcBrowser supports a subset of HTML 3.2 syntax. dcBrowser also 
supports the Hypertext Transfer Protocol (HTTP) 1.0 standard. 
Generally, dcBrowser supports the tags that provide simple display and 
data entry capabilities, such as text, password, and input types. It 
automatically filters content that cannot be displayed or processed on the 
data collection devices. 

dcBrowser also supports hypertext links, such as anchor, by assigning them 
to the function keys of the device. Since the 700 Series Mobile Computer 
does not have function keys, use the stylus to select hypertext links. When 
you write your application, be sure you understand the user interface and 
screen capabilities of the devices.  

Devices can only display one font with no attributes, such as <CITE>. You 
may want to use some of the tags to indicate how the text is used, not how 
it is displayed on the device. This release supports the heading hierarchy by 
using extra spacing and indentation.  
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Unsupported HTML Features 
The following list explains some of the HTML features that are not 
currently supported by dcBrowser. Contact your local Intermec 
representative to determine which features will be implemented in future 
releases. 

• HTML tags that are inappropriate for the devices. These tags are either 
implemented as far as possible or ignored. The dcBrowser gateway filters 
the HTML tags that are beyond the device’s capability. 

• Plug-ins or other extension mechanisms, such as Java or ActiveX. 

• Client-side scripting languages, such as JavaScript or JScript. 

• Graphics. dcBrowser supports the image tag by using the alternate text 
attribute (ALT). The device displays the ALT text instead of the 
graphic. 

• HTML-like security. 

• Audible alerts, other than the standard beeps for the device. You can 
sound an optional beep a chosen number of times when the device 
displays a new screen. 

• Cookie support is limited to the session. 
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Summary of HTML v3.2 Tags 
The Worldwide web Consortium (W3C) has recommended that web 
browsers support the following HTML v3.2 tags. The device supports 
each of the tags in one of these three ways: 

• The device displays the tag as expected and documented in an HTML 
reference manual. 

• The device displays the text; however, since the device only supports 
one font, it displays the text, but ignores the attributes. 

• The device ignores the tag. 

For a complete description of HTML tags, see an HTML reference 
manual. 

Summary of HTML 3.2 Tags  

 
 
 
HTML Tag 

 
 
 
Description 

 
 
Supported as 
Documented 

 
 
Text Displayed, 
No Format 

 
Not 
Supported, 
Ignored 

Supported 
with Special 
Attributes or 
Notes 

<!--…> Comment X    

&lt; &gt; 
&amp 

Escape sequences X    

<A> Anchor    X 

<ADDRESS> Address  X   

<APPLET> Java Applet   X  

<AREA> Area   X  

<B> Bold X*    

<BASE> Base   X  

<BEEP> Beep X    

<BIG> Big text  X   

<BLOCKQUOTE> Block quote  X   

<BODY> Body X    

<BR> Line break X    

<CAPTION> Caption  X   

<CENTER> Center X    

<CITE> Citation  X   

<CODE> Code  X   

<DD> Definition  X   

<DFN> Definition  X   

<DIR> Directory list X    
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Summary of HTML 3.2 Tags (continued) 

 
 
 
HTML Tag 

 
 
 
Description 

 
 
Supported as 
Documented 

 
 
Text Displayed, 
No Format 

 
Not 
Supported, 
Ignored 

Supported 
with Special 
Attributes or 
Notes 

<DIV> Division  X   
<DL> Definition list  X   
<DT> Definition term  X   
<EM> Emphasized X*    
<EMBED> Embed   X  
<FONT> Font   X  
<FORM> Form X    
<FRAME> Frame   X  
<FRAMESET> Frame set   X  
<H1>…<H6> Heading 1…6 X    
<HEAD> head    X 
<HR> Horizontal rule X    
<HTML> HTML X    
<I> Italic  X   
<IMG> Inline image    X 
<INPUT> Form input    X 
<ISINDEX> Is index  X   
<ITCPRINT> Print    X 
<KBD> Keyboard  X   
<LI> List item  X   
<LINK> Link X    
<MAP> Map   X  
<MENU> Menu list X    
<META> Meta    X 
<NOBR> No break X    
<NOEMBED> No embed X    
<NOFRAMES> No frames X    
<OL> Ordered list  X   
<OPTION> Option   X  
<P> Paragraph    X 
<PARAM> Parameters   X  
<PRE> Preformatted text X    
<S> Strike  X   
<SAMP> Sample  X   
<SELECT> Form select  X   
<SMALL> Small text  X   
<SPAN> Span X    
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Summary of HTML 3.2 Tags (continued) 

 
 
 
HTML Tag 

 

 
Description 

 
 
Supported as 
Documented 

 
 
Text Displayed, 
No Format 

 
Not 
Supported, 
Ignored 

Supported 
with Special 
Attributes 
or Notes 

<STRIKE> Strike  X   
<STRONG> Strong  X   
<STYLE> Style   X  
<SUB> Subscript  X   
<SUP> Superscript  X   
<TABLE> Table    X 
<TD> Table data X    
<TEXTAREA> Form text area   X  
<TH> Table header X    
<TITLE> Title X    
<TR> Table row X    
<TT> Teletype  X   
<U> Underline X*    
<UL> Unordered list   X  
<VAR> Variable  X   
<WBR> Word break   X  

*The 6400 devices do not support the bold <B> tag. The JANUS devices do not support bold <B>, emphasized <EM>, 
and underline <U> tags. Emphasized displays as inverse text. 
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Special HTML Tags 
This section describes HTML tags with special attributes or notes that are 
particular to using these tags with dcBrowser. For a complete description 
of HTML tags, see an HTML reference manual. 

Anchor 
 Syntax: <A>…</A> 

 Attributes: href 

 Special Attributes:  key= Assigns a function key to the anchor when links are enabled. Using 
this attribute overrides the default function key assignments. 

 Notes: To use the href attribute, you must enable the links feature. When links 
are enabled, the dcBrowser gateway maps the first ten anchor tags in a web 
page to the device’s function keys in the order that they appear (on the 
502X, the dcBrowser gateway maps the first 12 anchor tags, mapping the 
last two to M1 and M2). On the device, the user sees the function key 
(e.g., F1), a greater-than sign (>), and the link. The user presses the 
appropriate function key to jump to the link. 

  Only http links are supported. 

 Example: <A HREF=”HELP.HTM” KEY=”F5”>HELP</A> 

  

If you press F5, the web server finds the HELP.HTM file, and the device 
displays the help web page. 



Chapter 2— Developing and Testing Your Application 

14 Data Collection Browser Client User’s Guide 

Beep 
 Syntax: <BEEP> 

 Attributes: repeat= Sets the number of beeps. The default number of repeats is 0. 
The valid range for repeats is 0 to 32,767. 

spacing= Sets the number of milliseconds between beeps. The valid range 
for spacing is 1 to 1100 msec. If you compare spacings below 30 
msec, you will not notice a difference in spacing. 

 Notes: To set the beep volume and frequency, see the user’s manual for your 
device. 

 Example: <BEEP REPEAT=3> 

The device beeps three times. 

Headings 
 Syntax: <H1>…</H1> 

<H2>…</H2> 
<H3>…</H3> 
<H4>…</H4> 
<H5>…</H5> 
<H6>…</H6> 

 Notes: <H1> is centered in uppercase letters with a blank line before and after the 
heading. 

  <H2> is left-justified with a blank line before and after the heading. 

  <H3> is left-justified in uppercase with a two-character indentation and a 
blank line before the heading. 

  <H4> is left-justified with a four-character indentation and a blank line 
before the heading. 

  <H5> is left-justified with a six-character indentation and a blank line 
before the heading. 

  <H6> is left-justified with an eight-character indentation and a blank line 
before the heading. 
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 Example: <H1>containers</H1> 

  

The device displays “containers” in uppercase letters with a blank line 
before and after the heading. 

Image 
 Syntax: <IMG> 

 Attributes: alt 

 Notes: Since some device screens cannot render graphics, dcBrowser displays the 
alt text. 

 Example: <IMG SRC=”TRIANGLE.GIF” ALT=”*”>1998 Player Roster 

  

The device displays the asterisk (*) instead of the TRIANGLE.GIF 
graphic. 
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Input 
 Syntax: <INPUT TYPE=> 

 Attributes: hidden 
int 
password 
reset 
submit 
text 
name 
value 
size 
maxlength 

 Special Attributes: cursor Positions the cursor in the last field containing the cursor 
attribute. 

transmit Creates an input field that is automatically submitted when 
it is filled with bar code data from the scanner. For more 
information, see “Using Auto-Transmit Fields” on 
page 25. 

key= Assigns a function key to be associated with the input type 
when links are enabled. When you press the key, whatever 
value is indicated is returned. Using this attribute overrides 
the default function key assignments.  

 Example code for returning the value “CR” when you press 
F5:  

 <INPUT TYPE=“submit” VALUE=“CR” KEY=F5> 

scanonly Accepts only scanner input for the field. 

dti_capture= Puts data in a field based on data type identifier. If a field is 
tagged to accept only scanned data with a certain set of 
leading characters, the data is routed to that field when you 
scan the bar code even if the cursor is not in that field.  

dti_strip Removes the data type identifier identified by the 
dti_capture from the scanned bar code. 

noscan Disables scanned input for the field. This field accepts 
input from the device’s keypad. 

 Notes: Use the value attribute to set a default value for the input field that is 
specified by the name attribute. 

The input field cannot extend beyond the right edge of the device’s screen. 
dcBrowser does not support viewporting. 

The MAXLENGTH attribute supports scrolling fields. You can set 
MAXLENGTH to any number, but the visible field length is set by the 
SIZE attribute. 
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 Example: <INPUT TYPE=”text” NAME=Birthday SIZE=8 MAXLENGTH=8 

TRANSMIT> 

  

When you scan bar code data into the B-DAY field, the device 
automatically sends the screen data to the web server. 

Meta 
 Syntax: <META> 

 Special Attributes: id= Sets the identification that appears in the dcBrowser 
gateway configuration screen in the Custom ID column. 
You can use this identification to identify a specific 
relationship between that device and the server. The 
identification can be any alphanumeric and special 
characters.  

download= Downloads a file from the base directory configured in the 
TFTP server running on the same PC as the dcBrowser 
gateway to a Trakker Antares terminal or CK30 computer. 
Enter the file path and name in the format 
“\file_path\file_name” after download=. Make sure the 
device you are downloading to has enough memory for the 
file. The file is initially downloaded to a TMP file name 
and then is renamed after the device fully receives it. You 
can use the download attribute to download a new 
dcBrowser client to the device. If you are loading a new 
dcBrowser client, use the reboot attribute to start the new 
dcBrowser client.  

reboot Restarts the dcBrowser client. 

 On the CK30, installs the DCBCK30.CAB file. 
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http-equiv= When you enter REFRESH as the value for this attribute, 
opens a screen after a specified delay. The screen and delay 
are specified in the content attribute. When the web server 
opens the screen, the web server can also send any special 
messages or relay controls to the device.  

content= Specifies the time delay in seconds and the screen to be 
opened after the delay triggered by the http-equiv attribute. 
Enter the time delay and screen information in the format 
“seconds;/new_screen.htm”. Valid values for the time delay 
are 1 to 65 seconds. The time delay starts from when the 
current screen was sent or the last key was pressed. The 
time delay resets after each key press or scan. When the 
new screen opens, any data that you entered in the 
previous screen is lost. If you press Enter or an assigned 
function key or scan data that has a transmit property in 
the field before the time delay runs out, the normal action 
associated with the current screen happens instead of 
opening the specified screen.  

reader_cmd= Sends Reader commands to the devices. To send the 
Reader command, you enter one command as 
“$+command” or multiple commands as 
“$+command,$+command1, …, $+commandn”.  

For a list of valid commands, see the appropriate manual: 

Device Manual 

Trakker Antares terminal Trakker Antares 2400 Family System 
Manual (P/N 071389) 

JANUS device The user’s manual for your device 

502X Data Collection PC 502X Data Collection PC System Manual 
(P/N 071479) 

6400 device 6400 Application Development Tools 
System Manual (P/N 070130) 

700 device (black and 
white screen) 

Help for the tools CD 

700 device (color screen) 700 Series Color Mobile Computer User’s 
Manual (P/N 961-054-031) 

CK30 computer Intermec Computer Command Reference 
(P/N 073529) 

CV60 computer Intermec Computer Command Reference 

  

returnserial Return the serial data with the screen data as a cookie 
named SERIN. On the device, set EOM for COM1 to 
\X0D and clear SOM. The serial data is returned as if you 
pressed Enter.  

relay Sets one or more relays. 
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getrelay Causes the current relay to be sent when the screen is 
returned. The data is returned in a hidden field named 
RELAY. 

 To set relay 1, send the value of: 

 char(“A”) + 0x1 

 To set relay 4, send: 

char(“A”) + 0x8 

getsi Causes the current system input (optical isolator input) to 
be sent when the screen is returned. The data is returned in 
a hidden field named SI. 

retonsi Causes a return of the screen data whenever a system input 
changes. 

 Notes: To use the id attribute, you must set the SHOW_USERID parameter in 
DCB.INI. For help, see the online help for the dcBrowser gateway. 

 Examples: <META HTTP-EQUIV=REFRESH CONTENT=“3;/testlist.asp”> 

After a 3-second delay (no activity on the device), testlist.asp is requested 
from the web server. 

<META READER_CMD=“$+SD0,$+BV0”> 

For Trakker Antares terminals, sends the Scan Ahead command and Beep 
Volume command to the terminal and turns off scan ahead and the beep 
volume. 

The following example code shows how to use returnserial. 

<%@ language=VBScript %> 
<META RETURNSERIAL> 
<form method=″GET″ 
action=″http://10.20.13.115:8008/roy/html/showserial.asp″> 
SHOW SERIAL <BR> 
 
<input type=text NAME=infield SIZE=20 MAXLENGTH=50 
TRANSMIT> 
<BR> 
query string = <%=Request.QueryString %><br> 
serdata=<%=Request.cookies(″SERIN″) %><br> 
 
<p> 
<br><a href=″rfmnt2.html″>ASP folder1</a> 
<br><input type=submit NAME=TESTSUB VALUE=PRESS> 
</form> 

Paragraph 
 Syntax: <P> 

 Attributes: None. 
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 Notes: The dcBrowser gateway puts a blank line before a paragraph and left 
justifies the paragraph. 

  Multiple paragraph tags have no cumulative effect. 

Print 
 Syntax: <ITCPRINT>…</ITCPRINT> 

 Special Attributes: transmit Transmits the status of the last print command. 

get Gets data from the attached device and sends the data to the 
host. 

baud= Sets the baud rate on the device to allowed values, for example 
9600. For valid baud rates, see the user’s manual for your device.  

data= Sets the data bits to 7 or 8. If this attribute is not used, the data 
bits are set to 8.  

end= Defines the end character for block of input. You can use any 
ASCII character from 00 to 7E hex values. For ASCII to hex 
conversion, see Appendix A, “ASCII to Hex Conversion.” You 
must use the TRANSMIT attribute with this attribute.  

flow= Sets the flow control. Valid values are: 

 D DSR with XON/XOFF 
X XON/XOFF 
N None (default)  

length= Limits the length of the input stream to any value from 00 to 
99. The default value is 99. 

message= Defines the message displayed on the device screen while 
printing. Use HTML code for non-alphanumeric characters. 
The default message is “RS-232 PORT IN USE PLEASE WAIT.”  

parity= Sets the parity. Valid values are: 

 O Odd 
E Even 
N None (default)  

start= Defines the start character for a block of input. You can use any 
ASCII character from 00 to 7E hex values. For ASCII to hex 
conversion, see Appendix A, “ASCII to Hex Conversion.” You 
must use the TRANSMIT attribute with this attribute.  

stop= Sets the stop bits to 1 or 2. The default is 1. 

timeout= Defines the timeout for input from serial port messages. You can 
set the timeout to 00 to 99 seconds. The default is 3 seconds. 

wait= Causes wait for clear to send (CTS). Use this attribute when 
communicating with a modem. The default is no wait. You can 
set the device to wait from 00 to 99 seconds. 
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 Note: Use the Print tag to pass control and data messages from the web server to 
a printer attached to the COM port of a Trakker Antares terminal, CK30 
handheld computer, or CV60 vehicle-mount computer or the IRDA port 
of a 502X Data Collection PC running the dcBrowser client. You need to 
enable printing on the 502X. For help, see Chapter 5, “502X Data 
Collection PCs.” Check with your Intermec sales representative for the 
availability of the Print feature with other products. 

For the Print tag, you must have a printer connected to the serial port of 
your device. For more information, contact your Intermec sales 
representative. 

The device will send whatever is between the Print tags to the printer (see 
the example). 

 Example: <ITCPRINT>Company Name for Label 
Heading</ITCPRINT> 

The printer attached to the device prints “Company Name for Label 
Heading.” 

Table 

 Syntax: <TABLE>…</TABLE> 

 Attributes: border 

 Special Attributes: scrollable= Determines how many table rows (<TR>) are displayed on the 
device’s screen at a time. If the table contains more rows than 
this setting, you need to decide how a user will scroll through 
the rows. 

up= If links are enabled, this attribute assigns a function key to be 
associated with scrolling to the previous section of the table. 

down= If links are enabled, this attribute assigns a function key to be 
associated with scrolling to the next section of the table. 

 Notes: If you have a scrollable table and links are disabled, F5 is hard-coded to 
scroll to the previous section of the table and F6 is hard-coded to scroll to 
the next screen. You must add HTML tags to your web page to provide 
this information for your user. 

The width of a column in a table is the size of the largest cell in the 
column. This includes the <TH> tag. 

Column data is flattened to a single row. That is, data does not wrap 
within a column cell. The cell width is widened to accommodate the data. 

Rows are automatically wrapped. 

Using the break tag <BR> in a table tag has no effect. 
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 Example: <TABLE BORDER SCROLLABLE=6 UP=”F5” DOWN=”F6”> 
<TR><TD ALIGN=LEFT>QB<TD>Moon 
<TR><TD ALIGN=LEFT>QB<TD>McNair 
<TR><TD ALIGN=LEFT>RB<TD>Bettis 
<TR><TD ALIGN=LEFT>RB<TD>Bennett 
<TR><TD ALIGN=LEFT>WR<TD>Thigpen 
<TR><TD ALIGN=LEFT>WR<TD>Johnson 
<TR><TD ALIGN=LEFT>TE<TD>Sharpe 
<TR><TD ALIGN=LEFT>K<TD>Stoyanovich 
<TR><TD ALIGN=LEFT>D<TD>Giants 
<TR><TD ALIGN=LEFT>WR<TD>Reed 
<TR><TD ALIGN=LEFT>RB<TD>Dunn 
<TR><TD ALIGN=LEFT>RB<TD>Levens 
</TABLE> 

 

  

Since the scrollable attribute is set to 6, the device only displays the first six 
lines of the table. If you press F6, the next lines appear. 

Example Web Page and HTML Code 
The RFSIGN.HTM file contains the HTML code for the home page of 
the sample application. This table shows two different ways that you can 
see the home page. If you run the sample application using the simulator, 
the simulator will display a web page similar to the screen on the left. If 
you use a web browser to open the RFSIGN.HTM file, your browser will 
display a web page similar to the screen on the right.  

To set up the sample application and web pages 

1 Copy the .EXE files from the \INTERMEC\DCBROWSER\EXAMPLES\ 
CGI_BASED\CGI\BIN directory to the CGI-BIN directory for your web 
server. 

2 Copy the .HTM files from the \INTERMEC\DCBROWSER\EXAMPLES\ 
CGI_BASED\HTML directory to the HTML directory for your web 
server. 
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Simulator Web Browser 

 

 

 

 

Note: To run the CGI_BIN sample application, you must disable the links 
feature. The ASP sample application is run with links enabled and is more 
typical of how you would build an application. 

After you open the web page, you can use either a text editor or a web 
browser to view the HTML code. If you use a web browser other than 
Internet Explorer or Netscape Communicator, see the documentation that 
came with your web browser. 

To use a text editor to view the HTML code 

1 Choose File > Open.  

2 Go to the \INTERMEC\DCBROWSER\HTML directory, and then 
choose RFSIGN.HTM. 

3 Click OK. 

To use Internet Explorer to view the HTML code 

• Choose View > Source.  

To use Netscape Communicator to view the HTML code 

• Choose View > Page Source.  

The RFSIGN.HTM file is printed next. 
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RFSIGN.HTM 

<HTML> 
<HEAD> 
<TITLE>RF SIGN ON</TITLE> 
</HEAD> 
<BODY> 
<CENTER> 
<H1>SIGN ON</H1> 
<FORM METHOD=POST ACTION="/cgi-bin/cgi.exe"> 
<BR> 
<BR> 
<TABLE> 
<TR ALIGN=LEFT> 
<TD ALIGN=RIGHT>OPERATOR: 
<TD ALIGN=LEFT><INPUT TYPE="text" NAME=UserID SIZE=8 MAXLENGTH=16> 
<TR ALIGN=LEFT> 
<TD ALIGN=RIGHT>PASSWORD: 
<TD ALIGN=LEFT><INPUT TYPE="Password" NAME=Password SIZE=8 MAXLENGTH=16> 
</TABLE> 
<BR> 
<BR> 
<TABLE BORDER> 
<TR> 
<TD ALIGN=CENTER> 
<TD ALIGN=CENTER> 
<TD ALIGN=CENTER> 
<TD ALIGN=CENTER> 
<TR> 
<TD ALIGN=CENTER>F1&gt ENTER 
<TD ALIGN=CENTER> 
<TD ALIGN=CENTER> 
<TD ALIGN=CENTER> 
</TABLE> 
<INPUT TYPE="hidden" NAME="FormName" VALUE="RfSign.htm"> 
<INPUT TYPE="submit" NAME="Action" VALUE="F1"> 
<INPUT TYPE="submit" NAME="Action" VALUE="F2"> 
<INPUT TYPE="submit" NAME="Action" VALUE="F3"> 
<INPUT TYPE="submit" NAME="Action" VALUE="F4"> 
<BR> 
<INPUT TYPE="submit" NAME="Action" VALUE="F5"> 
<INPUT TYPE="submit" NAME="Action" VALUE="F6"> 
<INPUT TYPE="reset"  NAME="Action" VALUE="F7"> 
<INPUT TYPE="submit" NAME="Action" VALUE="F8"> 
</CENTER> 
</FORM> 
</BODY> 
</HTML> 
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Advanced Features 
This section explains some features of dcBrowser that may not be standard 
for HTML applications. 

Using the Links Feature 
When you enable the links feature, dcBrowser assigns the Enter key 
(EN>), and then it assigns function keys to anchor tags and input 
type="submit" tags. Up to ten function keys are assigned to links in the 
order they are encountered in the HTML file. Only http links are 
supported, and you can control the function that is assigned. 

For example, 

<INPUT TYPE="submit" VALUE="Help" NAME="HlpScrn1"> 

In a normal web browser, a button that contains the name “Help” appears. 
When the user clicks this button, the form-processing sequence begins and 
the application tells the web server HlpScrn1=Help. If you enable the links 
feature, the device displays a function key, a greater-than sign, and the 
value that is the name of the button in a normal web browser: 

F1>Help 

When you press F1, the form-processing sequence begins, and the 
application tells the web server that HlpScrn1=Help (just as it would if the 
anchor was selected with a mouse in a standard browser). 

If you disable the links feature, the value is ignored, and the name is 
whichever function key was pressed. The application tells the web server 
that Action=function key. That is, if you press F1, the application tells the 
web server that Action=F1. The application handles function key 
responses.  

Using Auto-Transmit Fields 
dcBrowser supports using auto-transmit fields, and it supports using the 
scan-ahead and type-ahead features to enter data. Although not standard 
for HTML applications, these features are most useful for repetitive 
screens with long refresh rates, such as a timecard system in which people 
scan a badge as they walk through a door.  

Scan-ahead and type-ahead are always available. While the device is 
waiting for a new screen, all scanned and keyed data is buffered. When the 
device receives a new screen with input fields, it applies the buffered data 
to the new screen. If an auto-transmit field is filled in before the end of the 
screen is reached, the screen is transmitted, and the remainder of the 
scan-ahead or type-ahead data waits for the next screen.  
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If the device receives a new screen that has no input fields, the device 
assumes that the screen is an error message. All scan-ahead data and type-
ahead data are discarded.  

Type-ahead can include the arrow keys and any of the alphanumeric keys, 
but it cannot include action keys such as a function key or the Enter key.  

 

Note: Screens with input fields have no way to ensure that the scan-ahead 
data or type-ahead data is put in the correct field. The receiving 
application must validate the data. 

You can disable scan-ahead by: 

• using type-ahead. 

or 

• changing IMDCB.INI on the device so that SCANAHEAD equals 0. 

Transmitting on a Full Field 
The following procedure explains how to transmit the content of a full 
field without pressing Enter. For example, in a field with a Yes or No 
question, the data is transmitted when you press Y or N. 

To transmit on a full field 

1 Copy IMDCB.INI from your device. For help, see the user’s manual for 
your device. 

2 In IMDCB.INI, add TRANSMIT_ON_FULL. 

3 Save the changes to IMDCB.INI. Do not change the name of the INI 
file. 

4 Load IMDCB.INI on your device. For help, see the user’s manual for 
your device. 

5 In your HTML application, add TRANSMIT to the field tag that you 
want to have transmit when full. 

6 Load and run your application. 

Choosing the Field That Appears First 
When a screen appears, the cursor is placed in the first available field. If 
you want the cursor placed in another field when the screen appears, add 
CURSOR as a property for that field. The following code shows an 
example where the cursor would be placed in the Password field instead of 
the User ID field. 

<INPUT TYPE=″text″ NAME=UserID VALUE=″fatboy″ SIZE=19 
MAXLENGTH=32> 
<INPUT TYPE=″password″ CURSOR NAME=Password SIZE=9 
TRANSMIT> 
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About the Test/Software Only Gateway Environment 
Use the test environment to simulate running your HTML application 
before you run it in your data collection network. You can run your 
application on your PC using the client simulator. 

When you run the application on your PC, you are using three main parts: 
the web server, the local dcBrowser gateway, and the client simulator. To 
set up this test environment, follow the guidelines in “Configuring the 
Test/Software Only Gateway Environment” on page 31. 

 

Note: In the software only dcBrowser gateway environment, the test 
environment is the local dcBrowser gateway that you use on the Windows 
NT/2000/ME/XP server. The server requires an additional license file. For 
help placing the license file and configuring the dcBrowser gateway, see the 
online help for the gateway. 

Development Computer

CGI
modules

Local
dcBrowser
gateway

Database

Simulator

Logical data flow

0300U028.eps

HTML editor and 
development
tools
    

Language (C, JAVA,
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Understanding the Test Environment 
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Setting Up the Test/Software Only Gateway Environment 
Use the test/software only gateway environment to simulate running the 
HTML application on your PC.  

Minimum Requirements 
• PC (not provided by Intermec) 

- Intel-based, Pentium 
- 32 MB RAM 
- 10 MB available hard disk space 
- Screen must use a VGA device 
- CD-ROM drive 
- Windows NT/2000/ME/XP 

• web server 

• web browser—Internet Explorer 4.0 or later/Netscape Navigator 4.5 or 
later (not provided by Intermec) 

• dcBrowser simulator (on dcBrowser client CD) 

 

Note: A free web server is provided in INTERMEC\DCBROWSER\ 
DEVTOOLS. Intermec does not provide product support for the server. For 
help installing the web server, see the README.TXT. 

To set up the test/software only gateway environment 

1 Load a web server and a web browser on your PC. For help, see the 
documentation that came with your web server and web browser. 

2 Load the dcBrowser simulator on your PC. For help, see the next 
section, “Installing the Client Environment and Simulator.” This 
manual assumes that you keep the default directory and directory 
structure. 

3 Verify that your test environment works by running the sample 
application and web pages. For help, see “Setting Up the Sample 
Application and Web Pages” on page 31. 

4 Copy your application and web pages to the appropriate directories on 
the web server. For help, see “Testing Your Application” on page 34. 
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Installing the Client Environment and Simulator 
The dcBrowser simulator ships on each dcBrowser client CD-ROM. You 
can also download dcBrowser from the Intermec web site at 
www.intermec.com. 

To load the simulator 

1 Place the dcBrowser client CD into the CD-ROM drive on your 
Windows NT/2000/ME/XP computer. 

2 If you have AutoPlay enabled for your CD player, the CD automatically 
opens and the dcBrowser Setup Launcher screen appears; otherwise, run 
SETUP.EXE on the top level of the CD. The Welcome screen appears. 

3 Read the Welcome screen and click Next. The Software License 
Agreement screen appears. 

4 Read the Intermec Software License Agreement and click Yes. The 
Choose Destination Location screen appears. 

5 Choose the path where you want to install the simulator. 

The default directory is C:\INTERMEC. You can choose Browse to 
modify the default directory structure to meet your needs; however, 
Intermec recommends that you change only the drive letter, not the 
directory structure. 

6 Click Next. The Setup Type screen appears. 

7 Click Complete or Custom. Intermec recommends that you perform a 
complete setup. The Select Program Folder screen appears. 

8 Choose the Program Folder.  

The default program folder is Intermec. You can select another folder 
into which you want to copy your program icons. 

9 Click Next. The Start Copying Files screen appears. 

10 Review the current settings and click Next.  

If you need to return to a previous screen to make changes, click Back. 

11 Wait for the simulator to be installed on your PC. The Setup Complete 
screen appears.  
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When you restart your computer, a new program folder appears 
containing two icons: Run Simulator and Local dcBrowser Gateway. 
During installation, the files are loaded into a directory tree as shown next: 

INTERMEC 
  |-DCBROWSER 
  |    |-CLIENT 
  |        |-JANUS 
  |        |-TRAKKER 
  |        |-I5020 
  |        |-I6400 
  |        |-I700 
  |        |-CK30 
  |        |-CV60 
  |    |-DEV TOOLS 
  |    |-GATEWAY DOCS 
  |    |-DOCS 
  |    |-EXAMPLES 
  |        |-ASP 
  |        |-CGI_BASED 
  |        |-SIMPLE 
  |    |-GATEWAY 
  |-TOOLS 
      |-FILECOPY 
      |-JANUSIMAGEMANAGER 

Running Multiple Copies of the Simulator (Optional) 
If you want to run a loopback test with many end devices or have the 
simulator connect to a dcBrowser gateway that is not on the same PC as 
the simulator, you can set up multiple copies of the simulator.  

 

Note: Only the first copy of the simulator is associated with the function 
keys. 

To set up the simulator to run multiple copies 

• From a DOS prompt, type -hx.x.x.x -pport -isimid –l and 
press Enter. 

where: 

x.x.x.x is the IP address for the PC running the dcBrowser gateway, 
where x is a value from 0 to 255. 

port  is the port number the gateway is communicating through. 
The default is 4060. Only change the port number if you 
change the DCS_PORT parameter in the DCB.INI file. For 
more information about the DCB.INI file, see the online help 
for the dcBrowser gateway for NT. 

simid  is a unique ASCII string that identifies the simulator copy. 

-l  starts the loopback test. 
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Setting Up the Sample Application and Web Pages (Optional) 
When you load the simulator, a sample application and web pages are also 
loaded. Before you run your application and web pages in the test 
environment, test your test environment using the sample application and 
web pages. 

To set up the sample application and web pages 

1 Copy the .EXE files from the \INTERMEC\DCBROWSER\EXAMPLES\ 
CGI_BASED\CGI\BIN directory to the CGI-BIN directory for your web 
server. 

 

Note: If you use a Microsoft web server, you may need to create a 
virtual CGI-BIN that points to the directory where the files are 
installed. Make sure to choose the Execute check box when configuring 
that directory. 

2 Copy the .HTM files from the \INTERMEC\DCBROWSER\ 
EXAMPLES\CGI_BASED\HTML directory to the HTML directory for 
your web server. 

3 Start your web server. 

4 Start the Local dcBrowser Gateway. A DOS window appears. 

5 Start your web browser. 

Configuring the Test/Software Only Gateway Environment 
Test your application and web pages the same way that you set up the 
sample application and web pages.  

To run your application 

1 Copy your .EXE files to the CGI-BIN directory for your web server. 

 

Note: If you put your CGI scripts in a different directory than CGI-
BIN, you may need to modify your HTM files to tell them where to 
look for the CGI scripts. 

2 Copy your .HTM files to the HTML or home directory for your web 
server. 

3 Start your web server. 

4 From the Start menu, select Intermec > dcBrowser > local dcBrowser 
gateway. A DOS window appears. 

5 Configure the local dcBrowser gateway. For help, see “Configuring the 
Local dcBrowser Gateway” in the next section. 

6 From the Start menu, select Intermec > dcBrowser > run simulator. A 
simulator window appears. Press Ctrl-F1 to change the screen size. 
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Configuring the Local dcBrowser Gateway 
When you configure the local dcBrowser gateway, you must define Device 
0, which is the default configuration. Any devices that communicate with 
the same web server and require the same home page do not need a unique 
configuration. When a device connects to the gateway and it doesn’t have 
its own configuration (as determined by the device’s IP address), the 
gateway assigns it a new device ID and uses the Device 0 configuration. 
This device ID and configuration appear in the dcBrowser Device 
Mapping Configuration table. An asterisk by the device number indicates 
that this device uses the Device 0 configuration. After you start the 
simulator in a test environment with no unique device configurations, a 
device with IP address 127.0.0.1 appears in the table. 

You must create a unique configuration for any devices that do not 
communicate with the host defined for Device 0 or that need a home page 
different from Device 0. Assign the device a unique device number, and 
then fill in the rest of the fields. The device number and configuration for 
this device appear in the dcBrowser Device Mapping Configuration table. 
No asterisk appears by the device number.  

To configure the local dcBrowser gateway for the default configuration 

 

Note: If you access the Internet by using a proxy server, you must add 
127.0.0.1 to your Exceptions list. The Exceptions list contains the 
addresses that you do not want to use with a proxy server. 

1 Start the web browser. 

2 In the Address line or the Go to line, type: 

http://127.0.0.1:4050 

The dcBrowser Device Mapping Configuration screen appears. 

3 In the table below the configuration screen, click 0. The Device 0 
information appears in the configuration screen fields.  

4 In the Host IP:Port field, enter the IP address and port of the web 
server. If the web server is on the same PC as the simulator, type: 

 127.0.0.1:80  

5 In the Home Page field, enter the name of the web page that the web 
server sends to the device when the device is turned on. 

6 Enable or disable the Links, Post Device ID, and Lowercase 
parameters. For help, see the online help for the DCS 30X, G4X00, or 
for the software only dcBrowser gateway. 

7 Click Update. Verify your changes to Device 0 in the table. 

8 Click Save. Your changes are saved. 

You can also edit a device configuration. 
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To change a device configuration 

1 Click the device ID. 

2 Change the configuration fields and runtime parameters. 

3 Click Update. If the device ID had an asterisk after it indicating that it 
used the Device 0 configuration, the asterisk disappears. 

Changing the Local dcBrowser Gateway INI File (Optional) 
By changing parameters in the .INI file for the local dcBrowser gateway, 
DCB.INI, you can change the following features. For a standard 
installation, you can find the .INI file at \INTERMEC\DCBROWSER 
\GATEWAY\DCB.INI. For help changing DCB.INI, see the online help for 
the dcBrowser gateway. 

What You Can Configure Through DCB.INI 

What You Want To Do Parameter You Change in INI File 

Send the device’s ID in a cookie named IM_DEVICE as part of the host 
message. 

POST_RADIOID 

Display stdout. visible(stdout) 

Display the anchors with special attributes, such as light characters on a black 
background or underlined, or not highlighting anchor tags. 

ANCHOR_HIGHLIGHT 

Enable extensive performance data collection. ciperf 

Enable data accumulation in the CommonLogFormat scrolling log. CommonLogFormat 

Disable the requirement of a user name and password to get to the diagnostic 
screen for the dcBrowser gateway. 

DIAG_AUTHORIZATION 

Specify the user name and password for the configuration and diagnostic 
screens for the dcBrowser gateway.  

DIAG_USER/DIAG_PASS 

Enable the dispatch scrolling log. DispatchLog 

Define the value returned if links are disabled and you press Enter. ENTERKEY 

Allow the page to be longer than the device screen. EXPAND_ROWS 

Allow you to press Tab or the down arrow key to get to the top field from the 
bottom field. 

FIELD_WRAP 

Add a character to scanned data and a character to keyboard data to 
differentiate between scanned and keyboard input. 

FLAG_INPUT_TYPE 

Define the character to be sent with keyboard data. KEY_FLAG 

Define the character to be sent with scanned data. SCAN_FLAG 

Display text input fields with special attributes, such as light characters on a 
black background or underlined. 

INPUT_HIGHLIGHT 

Define where the license Pak files are if you placed them in a file other than 
LICPAK.TXT. 

ITCLICPAKFILE 

Disable configuring the dcBrowser gateway through the dcBrowser Device 
Mapping Configuration screen. 

NO_CONFIGURE 

Disable the return of cookies. NO_COOKIE 

Choose whether to display input tags with submit properties with the letter 
F, the function key number, and a greater-than sign (for example, F1>). 

NO_INPUT_INDICATOR 
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What You Can Configure Through DCB.INI (continued) 

What You Want To Do Parameter You Change in INI File 

Choose whether to display anchor tags with submit properties with the letter 
F, the function key number, and a greater-than sign (for example, F1>). 

NO_ANCHOR_INDICATOR 

Make sure there are no conflicts between key= settings in anchor and input 
tags and function keys automatically assigned when links are enabled. 

ORDER_LINKS 

Send the device’s serial number in a cookie, IM_SERIAL. POST_SERIAL_NUM 

Configure devices by serial number in a DHCP network. SERIAL_NO_CONFIGURE 

Display the user IDs on the dcBrowser Device Mapping Configuration 
screen. 

SHOW_USERID 

Display submit buttons with special attributes, such as light characters on a 
black background. 

SUBMIT_HIGHLIGHT 

Access submit buttons by pressing Tab. TAB_TO_SUBMIT 

Access the anchor tags by pressing Tab and select the submit buttons by 
pressing Enter. 

TAB_TO_ANCHOR 

When links are enabled, have the Enter key respond as a standard Enter key 
instead of an HTML submit tag. 

TRANSMIT_ON_RETURN 

Cause a screen to be transmitted when input is received from a scanner. TRANSMIT_ON_SCAN 

Turn on a special screen for use of logical names or IP addresses. UDP_WTP_ALLOWED 

On a 502X, using M1 instead of F11 and M2 instead of F12 for links. USE_M_KEYS 

Choose whether pressing Esc calls the previous screen. IGNORE_ESCAPE 

  

Testing Your Application 
1 Verify that the correct home page appears for each device. 

2 Using the simulator, run the application. Make sure that the data the 
web server returns is the data you expect. 

3 Using the simulator, test the application for unexpected user input or 
keystrokes. Verify that appropriate error messages appear. 

Setting Up the Runtime Environment 
To set up the runtime environment for the DCS 30X or G4X00, see the 
documentation that came with your DCS 30X or G4X00. To set up the 
runtime environment for the software only dcBrowser gateway, see the 
online help. 
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Trakker Antares Terminals 

 

This chapter explains how to determine if the dcBrowser client is loaded 
on your Trakker Antares terminal and how to load and run the dcBrowser 
client. Use this chapter to: 

• verify that the dcBrowser client is loaded. 

• load the dcBrowser client if it is not loaded. 

• configure your Trakker Antares terminals. 

• display different font types. 

• connect to the dcBrowser gateway. 

• run the dcBrowser client. 

3 
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Verifying the dcBrowser Client is Loaded 
If your Trakker Antares TCP/IP or UDP Plus terminals came preloaded 
with the dcBrowser client, go to “Configuring Your Trakker Antares 
Terminals” on page 38. 

To determine if you have the dcBrowser client loaded on your terminal 

1 On your terminal, access the TRAKKER Antares 2400 Menu System by 
pressing ) y 2 4 8 or by scanning this bar code: 

TRAKKER Antares 2400 Menu System 

 *..-.* 
 *..-.* 

 

Note: If your terminal has a Left Enter key (y), you must use it when 
entering the key sequences in Step 1; otherwise, just use the ; key. 

2 Choose System Menu from the Main Menu, and then choose File 
Manager. 

3 Select drive C and press ;. A list of applications that are loaded on 
your terminal appears. Look through this list for DCBT24.BIN, which is 
the dcBrowser client filename. 

If you have the dcBrowser client loaded on your terminal, go to 
“Configuring Your Trakker Antares Terminals” on page 38. 

If you do not have the dcBrowser client loaded, go to the next section, 
“Loading the dcBrowser Client.” 

Loading the dcBrowser Client 
This section explains how to load the dcBrowser client on your terminals. 
You can load the dcBrowser client on your terminals in one of the 
following four ways: 

 

Note: Currently, you can use the DCS 300 to download the dcBrowser 
client only to your UDP Plus terminals. 

• Use the Windows-based FileCopy utility. 

• Use the DOS utility, LOADER.EXE. 

• Use the Receive File or Transmit File reader commands. 

• Use a host application. 

This section explains how to use the FileCopy utility. For help using 
LOADER.EXE, reader commands, or a host application, refer to your 
Trakker Antares terminal user’s manual.  
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The FileCopy utility ships on the dcBrowser client CD. When you 
installed the simulator, this utility was loaded in the 
\INTERMEC\TOOLS\FILECOPY directory on your PC. 

To load DCBT24.BIN on your terminals using the FileCopy utility 

1 Connect the terminal to your PC. For help, see your Trakker Antares 
terminal user’s manual. 

2 Run FileCopy. The Intermec FileCopy Utility dialog box appears. 

   

3 Click the Terminal Type field down arrow. A list of terminals that the 
FileCopy utility supports appears. Choose TRAKKER. 

4 Check the COM port parameters and the serial parameters to verify that 
the settings for your PC match the values that are set for the terminal’s 
serial port. The FileCopy online help contains detailed information 
about using the utility. 

Use the Trakker Antares 2400 Menu System to configure the serial port 
parameters on the terminal. For help, see the Trakker Antares terminal 
user’s manual. 

5 If you are in the Trakker Antares 2400 Menu System, exit the menu 
system. 

6 Select the FileCopy tab. 

7 In the PC Filename and Path box, type: 

 C:\PROGRAMFILES\INTERMEC\DCBROWSER\CLIENT\TRAKKER\ 
DCBT24.BIN 

8 In the Terminal Filename and Path box, type: 

 C:DCBT24.BIN 
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9 Choose Download. The dcBrowser client is downloaded to your 
terminal. 

Configuring Your Trakker Antares Terminals 
Before the Trakker Antares terminal can communicate with the dcBrowser 
gateway, you must set the host IP address or the controller IP address to 
the dcBrowser gateway IP address. You must then set the network port to 
4055 for TCP/IP terminals or 05555 for UDP Plus terminals.  

To configure the network port 

1 On your terminal, access the TRAKKER Antares 2400 Menu System by 
pressing  ) y 2 4 8 or by scanning this bar code: 

TRAKKER Antares 2400 Menu System 

 *..-.* 
 *..-.* 

 

Note: If your terminal has a Left Enter key (y), you must use it when 
entering the key sequences in Step 1; otherwise, just use the ; key. 

2 From the Main Menu, choose Configuration Menu > 
Communications Menu > Primary Network. The Primary Network 
screen appears. 

TCP/IP UDP Plus 

  

   PRIMARY NETWORK

Activate:

  Disabled

Host IP Addr:

  0.0.0.0

Terminal IP Address:

  0.0.0.0

OK CANCEL

 

   PRIMARY NETWORK

Activate:

  Disabled

Controller IP Addr:

  0.0.0.0

Terminal IP Address:

  0.0.0.0

OK CANCEL

 

3 Set the Activate field to 2.4 GHz RF, Ethernet, or 802.11b. 

4 Set the Host IP Address field or the Controller IP Address field to the 
dcBrowser gateway IP address. 

5 Set the Terminal IP Address field to the IP address of the terminal and 
press ;. The Communications menu appears. 

6 Choose Advanced Network. The Advanced Network screen appears.  
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TCP/IP            UDP Plus 

  

   ADVANCED NETWORK

Network Port: 4055

Subnet Mask:

 255.255.255.0

Default Router

 0.0.0.0.

TCP/IP Maximum

Transmit Timeout:

  020 sec  

  

  

 

 OK CANCEL
OK CANCEL

        

   ADVANCED NETWORK

Network Port: O5555

Subnet Mask:

 255.255.255.0

Default Router

 0.0.0.0.

TCP/IP Maximum

Transmit Timeout:

  020 sec  

  

  

 

 OK CANCEL
OK CANCEL

 

7 Set the Network Port field to 4055 for TCP/IP or 05555 for UDP Plus 
and press ;. The Communications menu appears. 

You may still need to configure your terminals to communicate with the 
access points. For help, see your terminal user’s manual and your access 
point user’s manual. 

Displaying Different Font Types 
The dcBrowser client displays the fonts on the Trakker Antares terminal as 
the 8 x 8 font type. To display different fonts, you can modify and 
download the IMDCB.INI file. 

To display different fonts 

1 Open IMDCB.INI in a text editor. In a standard installation, 
IMDCB.INI is in C:\PROGRAMFILES\INTERMEC\DCBROWSER\ 
CLIENT\TRAKKER\IMDCB.INI. 

2 Enter the following lines (only available with firmware v7.0 and above): 

 #set font to fonttype 
IM_COMMAND=$+DTX 

where  

#set font to fonttype is a comment letting you know what you have set 
the font type to (fonttype indicates the font type, 
such as 8 x 8) 

IM_COMMAND  is the dcBrowser client command to set the font 
type 

$+DT  is the Trakker Antares configuration command to 
set the font type 
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X  is one of the following values: 

  0 Font type 8 x 8 
1 Font type 8 x 16 
2 Font type 16 x 16 
6 Font type 5 x 6 
7 Font type 6 x 8 
8 Font type 8 x 10 
9 Font type 12 x 16 

3 Save the changes to IMDCB.INI. 

4 Load IMDCB.INI on your terminal. For help, see “Loading the 
dcBrowser Client” on page 36 and replace DCBT24.BIN with 
IMDCB.INI in the instructions. 

Connecting to the dcBrowser Gateway 
After you start the web server and the dcBrowser gateway, you can start 
running your HTML application on your devices.  

To connect to the dcBrowser gateway 

• Scan this bar code: 

 Run Program C:DCBT24.BIN 

 */O/OC/ZDCBT24.BIN* 
 *//C:DCBT24.BIN* 

Or, 

1 On your terminal, access the TRAKKER Antares 2400 Menu System by 
pressing  ) y 2 4 8 or by scanning this bar code: 

TRAKKER Antares 2400 Menu System 

 *..-.* 
 *..-.* 

 

Note: If your terminal has a Left Enter key (y), you must use it when 
entering the key sequences in Step 1; otherwise, just use the ; key. 

2 From the Main Menu, choose System Menu > File Manager. The File 
Manager screen appears. 

3 Select drive C and press ;. A list of applications that are loaded on 
your terminal appears. 

4 Select DCBT24.BIN and press ;. The dcBrowser client starts and the 
terminal’s home page appears. 
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The home page is the starting screen of the application. If you need to 
restart the home page or if communication between the client and the 
dcBrowser gateway is disconnected, press Ctrl-P to restart 
communications with the dcBrowser gateway, or to return to the home 
page. 

Running the dcBrowser Client 
When you are running your HTML application, follow these guidelines:  

• Use the cursor keys or Tab key to navigate from field to field.  

• Use the device’s scanner and keyboard to enter data. 

• Use auto-transmit fields to cause a screen to automatically transmit 
when data is scanned into a specific field. For help, see “Using Auto-
Transmit Fields” on page 25. 

• Access the hypertext links by pressing the appropriate function key.  

• Press Ctrl-P to restart communications with the dcBrowser gateway if 
you want to restart at the home page. 

If you reboot the terminal, the terminal restarts the dcBrowser client when 
it finishes rebooting. 

The following table lists special dcBrowser client key combinations that 
you may want to use while you are running your HTML application. 

dcBrowser Client Key Combinations 

Client Keys Description 

Ctrl-C Clear screen 

Ctrl-D Toggle Debug mode 

Ctrl-P  Restart communications with dcBrowser gateway and return to 
home page 

Ctrl-N  Ping the dcBrowser gateway 

Ctrl-T Toggle Timing mode (shows round trip time on each screen) 

Ctrl-W Refresh screen 

Ctrl-X  Reboots the terminal and restarts the dcBrowser client 

Ctrl-] Decrease contrast 

Ctrl-} Increase contrast 

Ctrl-[ Increase volume 

Ctrl-{ Decrease volume 
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JANUS Devices 

 

This chapter explains how to determine if the dcBrowser client is loaded 
on your JANUS device and how to load and run the dcBrowser client. Use 
this chapter to: 

• load the dcBrowser client. 

• configure the dcBrowser client. 

• connect to the dcBrowser gateway. 

• run the dcBrowser client. 

 

Note: JANUS 900 MHz and batch devices do not support dcBrowser. 
JANUS UDP Plus devices do not support dcBrowser. 

 

4 
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Loading and Configuring the dcBrowser Client 
This section explains how to load the dcBrowser client (DCBJ24T.EXE) on 
your JANUS devices using the JANUS Image Manager utility, which ships 
on the dcBrowser client CD. When you installed the simulator, this utility 
loaded in the \INTERMEC\TOOLS\JANUSIMAGEMANAGER directory 
on your PC. For help using this utility, see the online help.  

To load the dcBrowser client on your JANUS device, you must use the 
JANUS Image Manager utility v1.71 or later, and you must have a disk 
with FTP PC/TCP v5.0. 

To load DCBJ24T.EXE on your devices 

1 Connect the JANUS device to your PC. For help, see your JANUS 
device user’s manual. 

2 On the PC, start the JANUS Image Manager utility. The Device 
Selection dialog box appears. 

  

3 Choose the JANUS device that you connected to your PC, and then 
choose 2.4 GHz. 

4 Fill in the rest of the fields, and then choose the right arrow button. The 
Load Images dialog box appears. 
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5 Fill in the fields, and then choose the right arrow. The Network and 
Protocol dialog box appears. 

  

6 Choose Customer application and PC/TCP (FTP Corp.), and then 
choose the right arrow. The FTP PC/TCP Options dialog box appears. 
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7 Insert the FTP PC/TCP v5.0 disk in the disk drive. Enter the path 
name in the PC/TCP for DOS field. 

8 Fill in the rest of the fields and choose the right arrow. The Radio 
Parameters dialog box appears. 

  

9 Fill in the fields and choose the right arrow. The Image Manager dialog 
box appears. 
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10 In the first PC column, click the directory that contains the 
DCBJ24T.EXE file. The default directory is 
\INTERMEC\DCBROWSER\CLIENT\JANUSTCP. 

11 Copy the DCBJ24T.EXE file to the middle JANUS C: column. 

12 In the JANUS C: column, double-click AUTOEXEC.BAT. A text editor 
opens the AUTOEXEC.BAT file. 

13 Find and delete these two lines: 

 IF EXIST APP.BAT CALL APP.BAT 
IF EXIST UNNET.BAT CALL UNNET.BAT 

You can also add a REM before each of these lines rather than delete 
them. 

14 Choose the Make, Save, and Load icon (JANUS device). The new 
image with the dcBrowser client is downloaded to your JANUS device. 

You do not need to configure the JANUS device for the host IP address or 
the network port. You can define these parameters when you run the 
application, or you can create a batch file that automatically runs the 
dcBrowser client. You add this batch file to the JANUS C drive. 

The following example also frees up space on the JANUS C drive by 
unloading the reader wedge TSR. 

Example Batch File 

rwtsr 
dcbj24t dcbrowsergatewayIP 4055 
rwtsr -d 

where dcbrowsergatewayIP is the dcBrowser gateway IP address. 
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Connecting to the dcBrowser Gateway 
• From the command line, type: 

 DCBJ24T dcbrowsergatewayIP 4055 

where dcbrowsergatewayIP is the DCS 30X, G4X00, or dcBrowser 
gateway IP address. The device’s home page appears. The home page is 
the starting screen of the application. If you need to restart the home 
page or if communication between the client and the dcBrowser 
gateway is disconnected, press a-P to restart communications with 
the dcBrowser gateway. 

Running the dcBrowser Client 
When you are running your HTML application, follow these guidelines: 

• Use the cursor keys to navigate from field to field.  

• Use the device’s scanner or keyboard to enter data. 

• Use auto-transmit fields with scan-ahead data and type-ahead data. For 
help, see “Using Auto-Transmit Fields” on page 25. 

• Access the hypertext links by pressing the appropriate function key.  

• Press a-P to restart communications with the dcBrowser gateway if 
your device has been inactive for a period of time. 

If you reboot the device, the device restarts the dcBrowser client when it 
finishes rebooting. 

This table lists special dcBrowser client key combinations that you may 
want to use while you are running your HTML application. 

dcBrowser Client Key Combinations 

Client Keys Description 

Ctrl-C Clear screen 

Ctrl-D Toggle Debug mode 

a-P Restart communications with dcBrowser gateway 

Ctrl-N Ping the dcBrowser gateway 

Ctrl-T Toggle Timing mode 

Ctrl-W Refresh screen 

Ctrl-] Decrease contrast 

Ctrl-} Increase contrast 

Ctrl-[ Increase volume 

Ctrl-{ Decrease volume 
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502X Data Collection PCs 

 

This chapter explains how to load and run the dcBrowser client on your 
502X Data Collection PC. Use this chapter to: 

• install and configure the dcBrowser client. 

• connect to the dcBrowser gateway. 

• run the dcBrowser client. 

 

5 
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Installing and Configuring the dcBrowser Client 
You can use the Application Manager component of Unit Manager or 
ActiveSync to load the dcBrowser client on your 502X. 

• Use File Manager to load applications on your 502X device over a 
network. 

• Use ActiveSync to load applications on your 502X device. The first time 
you connect to ActiveSync, you must connect the 502X device to your 
PC’s serial port and establish a connection. After the initial connection, 
you can connect to ActiveSync over the radio network. You can 
establish a serial link using an L502X Serial Communications Adapter, a 
D502X Serial Communications Dock, or a serial I/O card in the PC 
card slot. 

For more information about Application Manager and ActiveSync, see the 
502X Data Collection PC System Manual (P/N 071479). 

To install the dcBrowser client on the 502X 

1 Press C, and then press 3 to open the Start menu. 

2 Press [ or ] to highlight Run, and then press e. 

3 Select Browse, and then press e. 

 

Note: You can also choose to delete the CAB file as it is installed. Type 
setup/d yourfile.CAB in the Run dialog box, where yourfile is the name 
of the CAB file. Press e. The application will be installed and the CAB 
file deleted. 

4 Select the Windows list box. 

5 Select the CAB file, and press e. 

The 502X system software automatically associates the CAB file with 
SETUP.EXE and installs the application. SETUP.EXE extracts the entire 
contents of the CAB file into the \SETUPMP directory. SETUP.EXE then 
uses the information in the .INF file to copy files to their destinations, 
make registry changes, configure the application on the 502X, store the 
.INF file in the application directory, and store the uninstall information 
in the registry. 

 

Note: When you run SETUP.EXE, the contents of the .CAB file are 
preserved. You can also use /D, /d, /delete, or /DELETE to remove the 
.CAB file as the setup process progresses. 

If the .CAB file you are installing is very large or the available space on the 
502X is limited, you may need to use the /DELETE option, which frees 
more program memory by reducing the size of the .CAB file as application 
files are extracted. 
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IMPORTANT! SETUP.EXE writes status messages about the installation 
to the SETUP.LOG file. The SETUP.LOG is a text file located in the 
WINDOWS directory of the 502X. Errors or problems with the 
installation are not displayed on the 502X screen; only the messages in the 
SETUP.LOG indicate what has occurred. 

To configure TCP/IP on the 502X 

1 Run the Configuration application. 

2 Choose Configure and then choose Network. 

3 From the Network menu, choose Advanced, and ensure that UDP 
Plus is disabled. 

4 Choose Radio, and give the 502X an IP address and subnet mask. 

If you have an 802.11b radio, give the network name under NETWORK. 

If you have a WLI Forum OpenAir radio, give a domain number and 
security ID number, if set. 

To start TCP/IP on the 502X 

1 Start dcBrowser from the run menu or the desktop icon, if set. 

2 To set the IP and port number of the dcBrowser gateway, press Ctrl-F1 
when the splash screen appears showing the title and version number.  

3 Press Enter to save your configuration. 

To configure UDP Plus on the 502X 

1 Run the Configuration application. 

2 Choose Configure and the choose Network. 

3 From the Network menu, choose Advanced. 
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4 Select and enable UDP Plus, and configure any UDP Plus parameters. 
Press } to expand the UDP Plus parameter list. For a definition of each 
parameter, see the 502X Data Collection PC System Manual. 

5 Set the Controller IP Address to the IP address of the DCS 30X, 
G4X00, or the dcBrowser gateway. 

6 Select the Apply button, and then press e to save your changes. 

7 Exit the Configuration application. 

8 Warm boot the 502X to enable UDP Plus parameters. For help, see the 
5020 Data Collection PC User’s Manual (P/N 068975) or 5023 Data 
Collection PC User’s Manual (P/N 070698). 

After you have configured the 502X for a UDP Plus network, the  icon 
appears and remains on in the Notification Tray indicating that the 502X 
is communicating with the dcBrowser gateway. If the  icon appears, see 
the 5020 Data Collection PC User's Manual or 5023 Data Collection PC 
User’s Manual.  

Enabling the Print Tag 
If you want to use the Print tag, <ITCPRINT>, to pass control and data 
messages from the web server to a printer attached to the IRDA port on 
the 502X, add the following line to the IMDCB.INI file and download the 
file to the 502X Windows directory: 

SETPRINTING 

For a standard installation of the dcBrowser gateway, you can find the 
IMDCB.INI file at C:\PROGRAMFILES\INTERMEC\DCBROWSER\ 
CLIENT\5020\IMDCB.INI. 

 

Note: If you are using a 502X with less than 16MB x 32MB memory, 
enabling the Print tag will cause a noticeable start up delay. 

For help using the Print tag, see Chapter 2, “Developing and Testing Your 
Applications.” 

For help using the IRDA port, see the 502X Data Collection PC System 
Manual. 
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Connecting to the dcBrowser Gateway 
After you have loaded and configured the dcBrowser client on your 502X, 
change the following parameters in the INI file for the dcBrowser gateway. 

dcBrowser Gateway .INI Parameters 

Parameter Change Value to 

INPUT_HIGHLIGHT INVERSE 

ANCHOR_HIGHLIGHT UNDERLINE 

SUBMIT_HIGHLIGHT UNDERLINE 

TAB_TO_SUBMIT TRUE 

TAB_TO_ANCHOR TRUE 

  

For the software only dcBrowser gateway, the .INI file is DCB.INI. For the 
dcBrowser on a DCS 30X or G4X00, the INI file is WBS.INI. 

To change the INI parameters 

1 Open the .INI file in a text editor such as Notepad. 

2 Change the parameters to the required values. 

3 Save the changes to the .INI file. 

4 Exit the text editor. 

You are now ready to start the dcBrowser client and connect to the 
gateway. 

To start the dcBrowser client on your 502X 

• Choose Run from the Start menu. 

If you installed the application using the CAB method, press Ctrl-Esc 
until the dcBrowser icon is highlighted, and then press Enter.  

Running the dcBrowser Client 
When you are running your HTML application, follow these guidelines: 

• Use the cursor keys or Tab key to navigate from field to field.  

• Use the device’s scanner or keyboard to enter data. 

• Use auto-transmit fields to simplify data input. For help, see “Using 
Auto-Transmit Fields” on page 25. 

• Press the appropriate function key to access the hypertext links or input 
buttons.  

• Press Ctrl-P to return to the home page. 



Chapter 5— 502X Data Collection PCs 

54 Data Collection Browser Client User’s Guide 

This table lists special dcBrowser client key combinations that you may 
want to use while you are running your HTML application. 

dcBrowser Client Key Combinations 

Client Keys Description 

Ctrl-C Clear screen 

Ctrl-P Restart communications with dcBrowser gateway 

Ctrl-N Ping the dcBrowser gateway 

Ctrl-T Toggle Timing mode 

Ctrl-W Refresh screen 

Ctrl-[ Increase volume 

Ctrl-{ Decrease volume 

Ctrl-X Exit the dcBrowser client 

  

A configuration screen appears the first time you start the dcBrowser 
client. You can restart this configuration screen by pressing Ctrl-g at the 
splash screen. 
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RT1700, RT1100, and 6400 
Devices 

 

This chapter explains how to load and run the dcBrowser client on your 
6400 device and how to use dcBrowser with the RT1700 or the RT1100. 
Use this chapter to: 

• use the dcBrowser gateway with the RT1700 or RT1100. 

• verify that the dcBrowser client is loaded. 

• load the dcBrowser client if it is not loaded. 

• start the dcBrowser client. 

• run the dcBrowser client. 

 

Note: You can use the 6400 with either TCP/IP or WTP. Each protocol 
uses an .EXE file and an .INI file. The .EXE file is identical for each 
protocol; however, the .INI file settings are different for each protocol. 
Instructions for changing the .INI file settings are included in this chapter. 

 

6 
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Using the dcBrowser Gateway With the RT1700 or RT1100 
To use RT1700 or RT1100 devices with the dcBrowser gateway, you must 
configure the RT1700 or RT1100. 

To configure the RT1700 or RT1100 device 

• Configure the RT1700 or RT1100 to run Native terminal emulation as 
described in the RT1700 Radio Data Terminal User’s Guide (P/N 961-
047-068) or the 1100 Series Data Terminal User’s Guide (P/N 961-047-
069). You must configure the RT1700 as a WTP device in the 
DCS 30X or G4X00. 

The RT1700 or RT1100 does not support highlighting and tab to 
anchors. 

Verifying the dcBrowser Client Is Loaded 
If your 6400 came preloaded with the dcBrowser client, go to “Starting the 
dcBrowser Client” on page 62.  

To determine if you have the dcBrowser client loaded on your 6400 

1 Type dir at the DOS prompt. A list of the files loaded on your 6400 
appears. 

2 Look for the following two files: 

• N6400.EXE (the client program) 

• PSKNET.INI (the protocol parameter file) 

If these files are not on your 6400, go to “Loading the dcBrowser 
Client” in the next section. If these files are on your 6400, go to 
“Starting the dcBrowser Client” on page 62. 

Loading the dcBrowser Client 
This section explains how to load the dcBrowser client on your 6400 
device. You can load the dcBrowser client in one of the following ways:  

• Use TFTP. 

• Use Intersvr/Interlnk. 

• Use the Windows-based FileCopy utility. 

To use the dcBrowser client on the 6400, you must use one of the 
following two configurations: 

1 A 6400 with the original terminal emulation that includes Native 
terminal emulation. 
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Note: Some dcBrowser client features are limited when used with this 
configuration, and if you have a WTP network, you will need to use a 
DCS 30X or G4X00. 

2 The TCP/IP bundle for either the WLI Forum OpenAir radio or 
802.11b radio. You can order your 6400 to come with either 
configuration, or you can purchase the bundles separately and load 
them. For help loading the bundles, see the documentation that came 
with the bundle and the 6400 Hand-Held Computer User’s Manual (P/N 
961-047-093). 

For the second configuration, you need to copy the files in the following 
table to drive C on the 6400. For a standard installation of the DCS 30X, 
G4X00, or software only dcBrowser gateway, the files are in 
INTERMEC\DCBROWSER\CLIENT\I6400. 

Copy These Files to the 6400 

File Description 

IMDCB.INI This file provides commands needed to configure the scanner 
symbology. The file provides some example symbologies, but you 
can edit different symbologies using the reader configuration 
commands. For help using reader configuration commands, see 
the 6400 Application Development Tools System Manual (P/N 
070130). 

N6400.EXE This file is the dcBrowser client for the 6400. 

64SCN7A.EXE This file is the utility for accessing the scanner and runs as a 
terminate-and-stay resident (TSR) program. If you use a scanner 
on the 6400, run this file before running N6400.EXE. 

RL2PCM.COM This file is a radio driver. If you are using OpenAir TCP/IP, copy 
this file to the 6400. After you reboot the 6400, this file 
automatically runs. 

PSKNET.INI This file defines the host IP address. You need to edit this file to 
point to the server running the dcBrowser gateway. 

ITC64XFR.EXE This file is a utility that you can use to transfer files without 
using Interlnk/Intersvr. You can use ITC64XFR.EXE in 
conjunction with FileCopy by setting up FileCopy to transfer a 
file using XMODEM 1K.  

In FileCopy, you must set the serial port to the following 
settings: 

• Baud rate = 19200 
• Parity = None 
• Data bits = 8 
• Stop bits = 1 
• SOM = \x02 
• EOM = \x03 
• LRC = Disabled 
• Handshake = Disabled 
• Commands = Enabled, no TMF 
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Initially you can move these files to the 6400 using only TFTP or 
Interlnk/Intersvr. You can use FileCopy after you move ITC64XFR.EXE. 

Setting the Network Configuration 
Before you can run the dcBrowser client, you must set the 6400’s network 
configuration using chgparms. 

To set the network configuration using chgparms 

1 At a DOS prompt on your 6400, type chgparms and press Enter. A 
menu appears. For help getting to a DOS prompt, see the 6400 Hand-
Held Computer User’s Guide. 

2 Choose 1 to set up the 6400’s IP address and network configuration, 
which your network administrator provides. For more information 
about setting the 6400’s IP address and network configuration, see the 
6400 Hand-Held Computer User’s Guide. 

3 Choose 4 to set up the access point security ID, which your network 
administrator provides. For more information on the access point’s 
security ID, see the user’s manual for the access point. 

Transferring Files Using TFTP 
Before you can transfer files using TFTP, you need to set up the device IP 
address and establish a radio connection. For help see the 6400 Hand-Held 
Computer User’s Manual. You can use TFTP with your 6400 on Windows 
2000, Windows NT, and Windows XP. 

To set up the 6400 for TFTP 

• At a DOS prompt on the 6400, type tftp serve and press Enter. 

To transfer files 

1 Make sure you have the IP address for the 6400 and that the 6400 is 
communicating through an access point to your PC. 

2 Start a DOS session on your PC. 

3 Type tftp -i host put filename c:\filename  

where: 

-i specifies binary image transfer mode (also called octet). In 
binary image transfer mode, the file is transferred byte by 
byte. Use this mode to transfer files. 

host is the IP address for the 6400. 

put indicates that the file is going to the 6400. To transfer files 
from the 6400 to the PC, replace put with get. 

filename is the name of the file that you want to transfer. 
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c is the destination drive on the 6400. 

4 Press Enter. 

Transferring Files Using Interlnk/Intersvr 
To transfer files using Interlnk/Intersvr, your PC must be running 
Interlnk, which is part of MS-DOS.  

 

Note: Interlnk/Intersvr are not available in Windows NT and Windows 
2000. Use TFTP to transfer files. 

To transfer files 

1 Load Interlnk as a device driver in your CONFIG.SYS file on the PC by 
inserting the following statement at the end of CONFIG.SYS: 

 DEVICE=C:\DOS\INTERLNK.EXE /DRIVES:2 

The previous statement assumes that MS-DOS is located in the C:\DOS 
directory on your PC. The DRIVES:2 parameter allows mapping of two 
drives from the 6400. 

2 Reboot the PC. 

3 Connect the serial port on the 6400 to the serial port on the PC. For 
help, see the 6400 Hand-Held Computer User’s Manual. 

4 Press Ctrl-Alt-Del on the 6400 and then press Alt. The boot selection 
menu appears. 

 

Note: If Ctrl-Alt-Del does not boot the 6400, press Enter-Enter-Blue 
Shift-Yellow Shift at the same time. 

5 Select 5. The 6400 boots to the DOS prompt. 

6 At the DOS prompt on the PC, type interlnk and press Enter. The 
following chart appears: 

 C:\WIN>interlnk 

 Port=COM2 

 This Computer Other Computer 

 (Client) (Server) 

 -------------- ------------------------ 

  F: equals A: 

  G: equals C: 

7 Copy the files to drive G. 

8 Set the network configuration. For help, see “Setting the Network 
Configuration” on page 58. 
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Configuring the Host Connection 
You configure the host connection in the PSKNET.INI file, which you 
download to the 6400. This file determines which protocol is used (WTP 
or TCP/IP) and the connection information for that protocol. 

To edit PSKNET.INI 

1 Complete the PSKNET.INI file for each 6400. A sample of the 
PSKNET.INI file is shown below. 

For WTP For TCP/IP 
[net use] [net use] 

loaded-wtp-stack = true loaded-wtp-stack = false 

loaded-tcp-stack = false loaded-tcp-stack = true 

[wtp addresses] [pctcp addresses] 

host-name = DCS1 server-ip = IP of gateway 

domain-lanID = 2 port-use = 4055* 

terminal-number = 2  

* do not change this value 

 

Note: The PSKNET.INI file contains unique information for each 6400. 
You must complete the PSKNET.INI file for each 6400. 

2 Set [net use] section to match the protocol you are using. 

3 Set the [wtp addresses] or [pctcp addresses] section with the 
correct values for the system configuration.  

 

Note: For WTP, the host-name and domain-lanID may be the same for 
several or all of the terminals in a configuration. The host-name is a 
unique name that you configure through your DCS 30X or G4X00. The 
domain-lanID is a unique name that you configure through your access 
point software. Each device has a unique terminal number that 
corresponds to the device number on the dcBrowser Device Mapping 
Configuration screen. When configuring your devices, be sure to select 
WTP for the device connection type. 

Transferring Files Using FileCopy 
The FileCopy utility ships on the dcBrowser Client CD. When you 
installed the simulator, this utility was loaded in 
/INTERMEC/TOOLS/FILECOPY on your PC. 

To load the dcBrowser client using FileCopy 

1 On your PC, start FileCopy. 

2 Click the down arrow for the Terminal Type field and select 6400. 
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3 Select the COM Port Setup tab. 

  

4 Set the following port settings: 

• PC COM Port = the COM port that the 6400 is connected to 

• TRAKKER COM Port = COM1 

• Communication Protocol = Configurable 

• File Transfer Protocol = XMODEM 
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• Baud Rate = 6400’s baud rate. To set the 6400’s baud rate, type 
Mode Com1 Baud=baudrate at the 6400’s DOS prompt where 
baudrate is the new baud rate.  

5 Click the FileCopy tab. 

  

6 Under PC filename and path, click Browse and select the path to the 
N6400.EXE. For a standard installation, N6400.EXE should be in 
INTERMEC\DCBROWSER\CLIENT\I6400. 

7 Under Terminal Filename and Path, type c:\n6400.exe. 

8 Click Download. 

On the PC, a status window appears showing the progress of the 
transfer.  

Starting the dcBrowser Client 
After you have loaded and configured the dcBrowser client, you are ready 
to start the client. 

To start the dcBrowser client on the 6400 

1 Type loadscan. Two TSR programs run and then the DOS prompt 
returns. 

2 Type n6400. The following text appears: 

 Thin client for dcBrowser 

Then the web page for the device appears. 
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Running the dcBrowser Client 
When you are running your HTML application, follow these guidelines: 

• Use the cursor keys to navigate from field to field.  

• Use the device’s scanner or keyboard to enter data. 

• Use auto-transmit fields with scan-ahead data and type-ahead data. For 
help, see “Using Auto-Transmit Fields” on page 25. 

• Access the hypertext links by pressing the appropriate function key.  

• Press and release Ctrl, and then press U to restart communications 
with the gateway if your device has been inactive for a period of time. 

If you reboot the device, the device restarts the dcBrowser client when it 
finishes rebooting. 

This table lists special dcBrowser client key combinations that you may 
want to use while you are running your HTML application. 

dcBrowser Client Key Combinations 

Client Keys Description 

Ctrl-D Toggle Debug mode 

Ctrl-U Restart communications with dcBrowser gateway 

Ctrl-N Ping the dcBrowser gateway 

Ctrl-T Toggle Timing mode 

Ctrl-W Refresh screen 

Ctrl-X Exits the dcBrowser client 
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700 Series Mobile Computer 

 

This chapter explains how to load and run the dcBrowser client on your 
700 Series Mobile Computer. Use this chapter to: 

• install the dcBrowser client. 

• use ActiveSync to connect to your 700. 

• configure special features. 

• configure and start the dcBrowser client. 

• connect to the dcBrowser gateway. 

• run the dcBrowser client. 

 

7 
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Installing the dcBrowser Client 
If you did not order the 700 to come pre-loaded with the dcBrowser 
client, you need to install the dcBrowser client. After you install the 
dcBrowser toolkit on your desktop PC, these files are in the following 
path: 

C:\Intermec\dcBrowser\client\I700 

To install the dcBrowser client 

1 Copy DCB700.CAB to the 700 using ActiveSync. For help using 
ActiveSync, see the next section, “Using ActiveSync.” 

2 On the 700, select Start > Programs > File Explorer. 

3 Browse to the CAB file and tap the CAB file. The CAB file starts 
installing the dcBrowser client. When the installation is complete, the 
CAB file is automatically deleted. 

You can now configure and start the dcBrowser client. For help, see 
“Configuring and Starting the dcBrowser Client” on page 72. 

Using ActiveSync to Connect to the 700 
You can use ActiveSync to establish a connection between your desktop 
PC and a 700 for file viewing and synchronization, remote debugging, and 
other device management activities.  

 

The 700 should be powered by an AC power source when you use 
ActiveSync. 

Attention: Il faut alimenter le 700 par une source de courant AC lors 
de l’exécution du ActiveSync. 

When you perform a cold boot, you lose the configuration settings that 
enable a connection to ActiveSync. RF or Ethernet settings remain after a 
cold boot. 

Installing ActiveSync 
Instructions for using ActiveSync are provided with the product. 
ActiveSync can be downloaded from the Microsoft web site at 
www.microsoft.com/mobile/pocketpc/default.asp.  

To establish a partnership between a 700 and a desktop PC, you must use 
a serial cable, a USB cable, or a 700 Series Single Dock. To order a cable 
or dock, contact your Intermec sales representative. 
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To install ActiveSync and establish a partnership with your 700 

1 Download ActiveSync from the Microsoft web site and follow the 
onscreen instructions for installing it on your desktop PC. When the 
Get Connected screen appears, click Cancel. 

2 If you plan to use ActiveSync on a network or have multiple 700s 
connected to the same PC through USB cables, give each 700 a unique 
computer name. ActiveSync often fails to establish a new partnership 
with a device if other devices with the same device name are on the same 
network or PC. 

a Select Start > Settings > System tab > About > Device ID tab. 

b In the Device Name field, enter a unique computer name.  

3 Connect the 700 to your desktop PC using a serial cable, a USB cable, 
or a 700 Series Single Dock. For help, see the documentation that came 
with your cable or dock. 

If the 700 is turned off, turn it on. The 700 will shortly be 
communicating with your desktop PC and the Set Up a Partnership 
screen appears on your desktop PC. 

4 Follow the onscreen instructions for setting up a partnership. When the 
partnership has been established, the device name of your 700 appears 
in the ActiveSync window on your desktop PC. 

   

Now that the partnership has been established, ActiveSync handles all 
future connects and disconnects. 

Exploring the 700 
Once you have installed ActiveSync and established a partnership with 
your 700, you can use ActiveSync to explore, copy, and delete files on the 
700. 

To explore files on the 700 

1 Install ActiveSync and establish a partnership with the 700. For help, 
see the previous section, “Installing ActiveSync.” 
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2 In the ActiveSync window on your desktop PC, click Explore. 
ActiveSync starts a mobile device session in Windows Explorer. 

3 Browse the files on the 700. For help, see the ActiveSync and Windows 
Explorer documentation. 

4 Close the mobile device session, and disconnect from ActiveSync. 

Changing ActiveSync Settings 
You can change ActiveSync’s settings to customize synchronization to your 
needs. The connection must be inactive to change settings. 

To change ActiveSync settings on the 700 

1 Tap Start and then tap the ActiveSync icon. The ActiveSync screen 
appears. 

  

2 Tap Tools and then tap Options. The PC settings tab appears. 

  

3 ActiveSync is set to automatically connect to your desktop PC whenever 
the 700 is placed in the 700 Series Single Dock or whenever the serial 
cable is attached. To change the baud rate from the default (115200 
baud), tap the arrow to the right of 115200 Default and choose a 
different baud rate from the drop-down list. 
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To disable the automatic connection setting, uncheck the box next to 
Enable synchronization when cradled using. 

If you chose to establish a partnership with more than one desktop PC, 
you can change the desktop PC that the 700 connects to. To change the 
desktop PC, tap the arrow to the right of your PC’s name and choose a 
different PC from the drop-down list. 

4 Tap OK. The main ActiveSync screen appears. For help with changing 
other settings, see the ActiveSync online help. 

Reconnecting to Your Desktop PC 
After you have created a partnership using ActiveSync, use it to re-establish 
the connection between the 700 and your desktop PC. 

To reconnect a 700 to a desktop PC using ActiveSync through a serial connection 

1 Connect the 700 to your desktop PC with a serial cable, a USB cable, or 
a 700 Series Single Dock. 

If ActiveSync is set to automatically connect to your desktop PC 
whenever the 700 is cradled, the ActiveSync connection screen appears 
on your desktop PC. 

If ActiveSync is not set to automatically connect, continue with the next 
step. 

2 On the 700, tap Start and then tap ActiveSync. The ActiveSync screen 
appears. 

3 Tap Sync. ActiveSync connects to your desktop PC. 

4 To disconnect, tap Stop. ActiveSync disconnects from the desktop PC. 

To reconnect an RF 700 to a desktop PC using ActiveSync 

1 Make sure the 700 is in range of an access point. On the 700, tap Start 
and then tap ActiveSync. The ActiveSync screen appears. 

2 Tap Sync. ActiveSync connects to your desktop PC. 

3 To disconnect, tap Stop. ActiveSync disconnects from the desktop PC. 
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Configuring Special Features (Optional) 
By changing the dcBrowser client INI file (IMDCB.INI), you can 
configure the features described in the following table. 

Features Configured Through IMDCB.INI 

Feature Description INI Parameter 

User interface lockdown Protects the 700 from unauthorized use 
of the Start menu and removes the 
caption bar allowing two extra text lines 
on the screen. 
To enable this feature, set the INI 
parameter to 1. 
To disable this feature, set the INI 
parameter to 0. This is the default 
setting. 

GUILockDown 

Setup screen link  Removes the (Press here for Setup) 
link on the splash screen. The IP 
configuration screen will still appear 
under the following circumstances even 
though the (Press here for Setup) link 
is not visible: 

• When you start the dcBrowser client 
without a valid server IP address 
defined in the INI file. A valid IP 
address must be other than 0.0.0.0 
and have all four segments where 
each segment is between 1 and 255. 

• When you start the dcBrowser client 
without a valid port number defined 
in the INI file. The port number 
must be greater than 0 and less than 
or equal to 65535. 

To enable this feature, set the INI 
parameter to 1. 

To disable this feature, set the INI 
parameter to 0. This is the default 
setting. 

HIDE_SPLASH_SETUP_OPTION 

Virtual keyboard Make the system tray button for the 
virtual keyboard available and allow for 
a custom virtual keyboard that provides 
function keys F1 through F24. 

To not show the system tray button for the 
virtual keyboard (default setting) 

• Set 

 ENABLE_SIP=0 

ENABLE_SIP 

FUNCTION_KEY_SIP 
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Features Configured Through IMDCB.INI (continued) 

Feature Description INI Parameter 

Virtual keyboard 
(continued) 

To show the system tray button and allow 
the standard virtual keyboard 

• Set 

 ENABLE_SIP=1 
 FUNCTION_KEY_SIP=0 

To show the system tray button and allow 
the custom virtual keyboard 

• Set 

 ENABLE_SIP=1 
 FUNCTION_KEY_SIP=1 

To display the function keys 

• Press the following key on the 
custom virtual keyboard: 

  

ENABLE_SIP 

FUNCTION_KEY_SIP 

Network timeout Sets how long in seconds the dcBrowser 
client will try to connect to the server 
before prompting you with a connect or 
error message that allows you to retry or 
cancel.  

You can set the timeout from 1 to 180 
seconds. The default value is 6 seconds. 

NETWORK_CNX_TIMEOUT_SECONDS 

   

To change IMDCB.INI 

1 Generate a default IMDCB.INI file. 

a Run the dcBrowser client. For help, see “Running the dcBrowser 
Client” on page 73. 

b When the IP configuration screen appears, enter a server IP address 
in the format n.n.n.n where n is a number from 1 to 255. 

c Press Enter. 

d Press Gold-9, Ctrl-E, or Ctrl-X to close the dcBrowser client. 

2 Use ActiveSync to copy IMDCB.INI from the 700 root directory 
(Mobile Device\My Pocket PC) to a desktop PC. For help using 
ActiveSync, see the previous section, “Using ActiveSync to connect to 
the 700.” 

3 If your 700 has an SDRAM card, use ActiveSync to delete IMDCB.INI 
from the directory \SDMMC Disk. If you do not delete IMDCB.INI from 
this directory, the dcBrowser client will not use your modified 
IMDCB.INI file after you copy it onto the 700. 

4 On the desktop PC, open IMDCB.INI in a text editor, such as Notepad. 
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5 Edit the parameters you want to change. For help, see the previous 
table. 

6 Save the changes to IMDCB.INI. Do not change the name of the INI 
file. 

7 Use ActiveSync to copy the edited IMDCB.INI file to the 700 root 
directory. Your changes take effect the next time you run the dcBrowser 
client. 

Configuring and Starting the dcBrowser Client 
Before you can run the dcBrowser client, you need to configure TCP/IP 
on the 700. You also need to find the IP address and port number for the 
PC, DCS 30X, or G4X00 that the dcBrowser gateway is running on. 

To configure TCP/IP on the 700 

1 Select Start > Settings. The Control Panel appears. 

2 Tap the Connections tab. 

3 Tap Network. 

4 Under Adapters installed, tap the Ethernet card driver you are using 
for your network.  

5 If you are using a dynamic host configuration protocol (DHCP) server, 
select Use server-assigned IP address. 

If you are not using a DHCP server, select Use specific IP address and 
enter the IP address, subnet mask, and default gateway for your 700. 
Your network administrator should provide you with this information. 

6 Tap OK. A message appears; tap OK. 

7 Tap the System tab and tap Wireless Network. 

8 Choose Access Point and tap Edit Profile. 

9 In the Network Name field, enter the network name. 

10 Tap OK twice. 

11 To exit the Control Panel, tap the round X button in the upper right 
corner of the screen. 

To start dcBrowser for the first time on the 700 

1 Select Start > dcb700. A splash screen appears showing the dcBrowser 
title and version number. 

2 To set the IP address and port number of the dcBrowser gateway, tap 
(Press Here for Setup).  
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Note: If the dcBrowser client has not been configured with a valid IP 
address and port number, the IP configuration screen automatically 
appears. 

3 Press Enter to save your configuration. 

Connecting to the dcBrowser Gateway 
After you have loaded and configured the dcBrowser client on your 700, 
change the following parameters in the .INI file for the dcBrowser 
gateway. 

INI File Parameters 

Parameter Change Value to 

INPUT_HIGHLIGHT INVERSE 

ANCHOR_HIGHLIGHT UNDERLINE 

SUBMIT_HIGHLIGHT UNDERLINE 

TAB_TO_SUBMIT TRUE 

TAB_TO_ANCHOR TRUE 

  

For the software only dcBrowser gateway, the .INI file is DCB.INI. For the 
dcBrowser on a DCS 30X or G4X00, the .INI file is WBS.INI. 

To change the INI parameters 

1 Open the .INI file in a text editor such as Notepad. 

2 Change the parameters to the required values. 

3 Save the changes to the .INI file. 

4 Exit the text editor. 

You are now ready to start the dcBrowser client and connect to the 
gateway. 

To start the dcBrowser client on your 700 

• Select Start > dcb700.  

Running the dcBrowser Client 

 

Note: You need to use the soft keyboard for the key sequences that include 
the Ctrl key. 

When you are running your HTML application, follow these guidelines: 

• Use the cursor keys, Tab key, or stylus to navigate from field to field.  
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• Use the device’s scanner or keyboard to enter data. 

• Use auto-transmit fields to simplify data input. For help, see “Using 
Auto-Transmit Fields” on page 25. 

• Use the stylus to access the hypertext links or input buttons.  

Or 

Use the links associated with function keys that you access through the 
custom virtual keyboard. For help enabling the custom virtual keyboard, 
see “Configuring Special Features (Optional)” on page 70. 

• Press Gold-7 to return to the home page. 

These tables list special dcBrowser client key combinations that you may 
want to use while you are running your HTML application. 

The following table lists key combinations for the virtual keyboard. 

dcBrowser Client Key Combinations 

Virtual Keys Description 

Ctrl-C Clear screen 

Ctrl-N Ping the dcBrowser gateway 

Ctrl-T Toggle Timing mode 

Ctrl-W Refresh screen 

Ctrl-[ Increase volume 

Ctrl-{ Decrease volume 

  

This table lists key combinations for keys on the 700. 

700 Key Combinations 

Client Keys Description 

Gold-7 Restart communications with dcBrowser gateway 

Gold-9 Exits the dcBrowser client 

  

To open the IP configuration screen, tap “Press Here for Setup” only at 
the 700 splash screen. 
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CK30 Handheld Computer 

 

This chapter explains how to determine if the dcBrowser client is loaded 
on your CK30 Handheld Computer and how to load and run the 
dcBrowser client. Use this chapter to: 

• verify that the dcBrowser client is loaded. 

• load and launch the dcBrowser client. 

• set up to print through the COM port. 

• configure your CK30 Handheld Computer. 

• set a connection delay. 

• run the dcBrowser client. 
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Verifying the dcBrowser Client is Loaded 
If your CK30s came preloaded with the dcBrowser client, go to 
“Configuring Your CK30 Computers” on page 77. 

To determine if you have the dcBrowser client loaded on your computer 

• On your computer, access the System Main Menu by pressing the green 
C key and then the orange B key. A list of applications that are 
loaded on your computer appears. Look through this list for dcBrowser. 

If you have the dcBrowser client loaded on your computer, go to 
“Configuring Your CK30 Computers” on page 77. 

If you do not have the dcBrowser client loaded, go to the next section, 
“Loading the dcBrowser Client.” 

Loading and Launching the dcBrowser Client 
You have two options for loading the dcBrowser client on the CK30. 

• To temporarily load the client, copy DCBCK30.EXE to the CK30. 

• To permanently load the client, copy DCBCK30.CAB and install the 
CAB file on the CK30. 

These files are on the dcBrowser client CD. 

To launch the dcBrowser client automatically on the CK30 every time you 
perform a warm or cold boot, make sure your CAB file places a shortcut to 
your application in the \Windows\StartUp folder. The dcBrowser client 
must be launched before the CK30 can communicate with the dcBrowser 
gateway. 

For help copying and loading applications, see the CK30 Handheld 
Computer User’s Manual (P/N 073528). 

Setting Up to Print Through the COM Port (Optional) 
You can change a registry key on the CK30 to set: 

• what COM port to print to. 

• COM port settings. 

• Bluetooth printing. 

The default registry key setting for printing is 

HKEY_LOCAL_MACHINE\SOFTWARE\INTERMEC\DCBROWSER\PRINTER_PORT=″COM2:,115200,n,8,
1,A″ 
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This registry key setting indicates that the CK30 prints through COM2 
using the following settings: 

Baud rate 115200 

Parity None 

Data bits 8 

Stop bits 1 

To change the COM port and COM port settings 

• Edit the PRINTER_PORT registry key to change the COM port to print 
to and to change the baud rate, parity, data bits, and stop bits for the 
chosen COM port. For supported values, see the Intermec Computer 
Command Reference Manual (P/N 073529). 

To set the registry key for Bluetooth printing 

• Set the PRINTER_PORT registry key to: 

 ″COM6:,BLUETOOTH″ 

The CK30 prints through its Bluetooth radio to a printer with a Bluetooth 
radio. 

Configuring Your CK30 Computers 
Before the CK30 computer can communicate with the dcBrowser gateway, 
you must set the host or controller IP address to the dcBrowser gateway IP 
address. You must then set the host or controller port to 4055 for TCP/IP 
computers or 05555 for UDP Plus computers.  

To configure the network port 

1 To open the System Main Menu, press C and then B. 

2 To set the host or controller IP address and the host or controller port, 
select Configuration Utility > Communications > PSK Settings > 
Remote Connection. 

3 To save changes, select Configuration Utility > Save to Flash and 
press Enter. 

You may still need to configure your computers to communicate with the 
access points. For help, see the CK30 Handheld Computer User’s Manual 
and your access point user’s manual. 
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Setting a Connection Delay (Optional) 
If the CK30 is communicating with your network through a non-Intermec 
access point, the dcBrowser client may fail to connect to the dcBrowser 
gateway after the CK30 has been warm booted. The dcBrowser client must 
wait for the CK30 to connect to a DHCP server or finish other network 
services before it can connect to the dcBrowser gateway. 

To set a connection delay 

1 Copy IMDCB.INI from the root directory on the CK30 to your 
desktop PC. For help, see the CK30 Handheld Computer User’s Manual. 

2 On your desktop PC, open IMDCB.INI in a text editor, such as 
Notepad. 

3 Add the following line: 

CONNECT_DELAY=delay 

where delay is the number of seconds you want the dcBrowser client to 
wait to connect after the CK30 warm boots. For example, adding the 
following line causes the dcBrowser client to wait 10 seconds before 
trying to connect. 

CONNECT_DELAY=10 

4 Save the changes to IMDCB.INI. Do not change the name of the INI 
file. 

5 Copy IMDCB.INI to the root directory on the CK30. For help, see the 
CK30 Handheld Computer User’s Manual. 

Running the dcBrowser Client 
When you are running your HTML application, follow these guidelines:  

• Use the cursor keys or Tab key to navigate from field to field.  

• Use the device’s scanner and keyboard to enter data. 

• Use auto-transmit fields to cause a screen to automatically transmit 
when data is scanned into a specific field. For help, see “Using Auto-
Transmit Fields” on page 25. 

• Access the hypertext links by pressing the appropriate function key.  

• Press Ctrl-P to restart communications with the dcBrowser gateway if 
you want to restart at the home page. 

If the dcBrowser client is set up to automatically launch, the computer 
restarts the dcBrowser client when it finishes rebooting. For help, see 
“Loading and Launching the dcBrowser Client” on page 76. 
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The following table lists special dcBrowser client key combinations that 
you may want to use while you are running your HTML application. 

dcBrowser Client Key Combinations 

Client Keys Description 

Ctrl-C Clear screen 

Ctrl-D Toggle Debug mode 

Ctrl-P  Restart communications with dcBrowser gateway and return to home 
page 

Ctrl-N  Ping the dcBrowser gateway 

Ctrl-T Toggle Timing mode (shows round trip time on each screen) 

Ctrl-W Refresh screen 

Ctrl-E or 
Ctrl-X 

Exits the dcBrowser client 
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CV60 Vehicle Mount 
Computer 

 

This chapter explains how to load and run the dcBrowser client on your 
CV60 Vehicle Mount Computer. Use this chapter to: 

• install the dcBrowser client. 

• use ActiveSync to connect to your CV60. 

• configure special features. 

• configure and start the dcBrowser client. 

• connect to the dcBrowser gateway. 

• run the dcBrowser client. 

 

9 
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Installing the dcBrowser Client 

 

Note: The dcBrowser client is only compatible with the Windows CE 
version of the CV60. 

If you did not order the CV60 to come pre-loaded with the dcBrowser 
client, you need to install the dcBrowser client. After you install the 
dcBrowser toolkit on your desktop PC, these files are in the following 
path:  

C:\Intermec\dcBrowser\client\CV60-CE 

To install the dcBrowser client 

1 Copy DCBCV60.CAB to the CV60 using ActiveSync. For help using 
ActiveSync, see the next section, “Using ActiveSync to Connect to the 
CV60.” 

2 On the CV60, select Start > Programs > Windows Explorer. 

3 Browse to the .CAB file and double tap the .CAB file. The .CAB file 
starts installing the dcBrowser client. When the installation is complete, 
the .CAB file is automatically deleted. 

You can now configure and start the dcBrowser client. For help, see 
“Configuring and Starting the dcBrowser Client” on page 86. 

Using ActiveSync to Connect to the CV60 
You can use ActiveSync to establish a connection between your desktop 
PC and a CV60 for file viewing and synchronization, remote debugging, 
and other device management activities.  

Installing ActiveSync 
Instructions for using ActiveSync are provided with the product. 
ActiveSync can be downloaded from the Microsoft web site at 
www.microsoft.com/mobile/pocketpc/default.asp.  

To establish a partnership between a CV60 and a desktop PC, you must 
use a serial cable. To order a cable, contact your Intermec sales 
representative. 

To install ActiveSync and establish a partnership with your CV60 

1 Download ActiveSync from the Microsoft web site and follow the 
onscreen instructions for installing it on your desktop PC. When the 
Get Connected screen appears, click Cancel. 
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2 If you plan to use ActiveSync on a network, give each CV60 a unique 
computer name. ActiveSync often fails to establish a new partnership 
with a device if other devices with the same device name are on the same 
network. 

a Select Start > Settings > Control Panel, then double tap System, 
and select the Device Name tab. 

b In the Device name field, enter a unique computer name, and click 
OK.  

3 In ActiveSync on your desktop PC, select File > Connection Settings. 
The Connection Settings dialog box appears. 

4 Select Allow serial cable or infrared connection to this COM port, 
and select the COM port that you are going to use. 

If you want ActiveSync to connect to your CV60 over an Ethernet or 
wireless connection, select Allow network (Ethernet) Remote Access 
Service (RAS) server connection with this desktop computer. 

5 Click OK. 

6 Connect the CV60 to your desktop PC using a serial cable. For help, see 
the documentation that came with your cable. 

If the CV60 is turned off, turn it on. The CV60 will shortly be 
communicating with your desktop PC and the Set Up a Partnership 
screen appears on your desktop PC. 

7 Follow the onscreen instructions for setting up a partnership. When the 
partnership has been established, the device name of your CV60 appears 
in the ActiveSync window on your desktop PC. 

Now that the partnership has been established, ActiveSync handles all 
future connects and disconnects. 

Exploring the CV60 
Once you have installed ActiveSync and established a partnership with 
your CV60, you can use ActiveSync to explore, copy, and delete files on 
the CV60.  

To explore files on the CV60 

1 Install ActiveSync and establish a partnership with the CV60. For help, 
see the previous section, “Installing ActiveSync.” 

2 In the ActiveSync window on your desktop PC, click Explore. 
ActiveSync starts a mobile device session in Windows Explorer. 

3 Browse the files on the CV60. For help, see the ActiveSync and 
Windows Explorer documentation. 

4 Close the mobile device session, and disconnect from ActiveSync. 
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Reconnecting to Your Desktop PC 
After you have created a partnership using ActiveSync, use it to re-establish 
the connection between the CV60 and your desktop PC. 

To reconnect a CV60 to a desktop PC using ActiveSync through a serial connection 

1 Connect the CV60 to your desktop PC with a serial cable. 

If ActiveSync is set to automatically connect to your desktop PC 
whenever the CV60 is attached, the ActiveSync connection screen 
appears on your desktop PC. 

If ActiveSync is not set to automatically connect, continue with the next 
step. 

2 On the CV60, double tap the ActiveSync icon. The ActiveSync 
connection screen on your desktop PC displays Connected. 

3 To disconnect, click Stop on your desktop PC. ActiveSync disconnects 
from the desktop PC. 

To reconnect an RF CV60 to a desktop PC using ActiveSync 

1 Make sure the CV60 is in range of an access point. On the CV60, 
double tap the ActiveSync icon. The ActiveSync connection screen on 
your desktop PC displays Connected. 

2 To disconnect, tap Stop on your desktop PC. ActiveSync disconnects 
from the desktop PC. 

Configuring Special Features (Optional) 
By changing the dcBrowser client INI file (IMDCB.INI), you can 
configure the features described in the following table. 

Features Configured Through IMDCB.INI 

Feature Description INI Parameter 

User interface lockdown Protects the CV60 from unauthorized use of 
the Start menu and removes the caption bar 
allowing two extra text lines on the screen. 
The taskbar remains visible but tapping on 
the buttons does not open the menus or 
configuration screens. 
To enable this feature, set the INI parameter 
to 1. 
To disable this feature, set the INI parameter 
to 0. This is the default setting. 

GUILockDown 
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Features Configured Through IMDCB.INI (continued) 

Feature Description INI Parameter 

Setup screen link  Removes the (Press here for Setup) 
link on the splash screen. The IP 
configuration screen will still appear 
under the following circumstances even 
though the (Press here for Setup) link 
is not visible: 

• When you start the dcBrowser client 
without a valid server IP address 
defined in the INI file. A valid IP 
address must be other than 0.0.0.0 
and have all four segments where 
each segment is between 1 and 255. 

• When you start the dcBrowser client 
without a valid port number defined 
in the INI file. The port number 
must be greater than 0 and less than 
or equal to 65535. 

To enable this feature, set the INI 
parameter to 1. 

To disable this feature, set the INI 
parameter to 0. This is the default 
setting. 

HIDE_SPLASH_SETUP_OPTION 

Network timeout Sets how long in seconds the dcBrowser 
client will try to connect to the server 
before prompting you with a connect or 
error message that allows you to retry or 
cancel.  

You can set the timeout from 1 to 180 
seconds. The default value is 6 seconds. 

NETWORK_CNX_TIMEOUT_SECONDS 

   

To change IMDCB.INI 

1 Generate a default IMDCB.INI file. 

a Run the dcBrowser client. For help, see “Running the dcBrowser 
Client” on page 87. 

b When the IP configuration screen appears, enter a server IP address 
in the format n.n.n.n where n is a number from 1 to 255. 

c Press Enter. 

d Press Ctrl-E or Ctrl-X to close the dcBrowser client. 

2 Use ActiveSync to copy IMDCB.INI from the CV60 root directory 
(Mobile Device) to a desktop PC. For help using ActiveSync, see the 
previous section, “Using ActiveSync to Connect to the CV60.” 

3 On the desktop PC, open IMDCB.INI in a text editor, such as Notepad. 
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4 Edit the parameters you want to change. For help, see the previous 
table. 

5 Save the changes to IMDCB.INI. Do not change the name of the INI 
file. 

6 Use ActiveSync to copy the edited IMDCB.INI file to the CV60 root 
directory. Your changes take effect the next time you run the dcBrowser 
client. 

Configuring and Starting the dcBrowser Client 
Before you can run the dcBrowser client, you need to configure TCP/IP 
on the CV60. You also need to find the IP address and port number for 
the PC, DCS 30X, or G4X00 that the dcBrowser gateway is running on. 

To configure TCP/IP on the CV60 

1 Select Start > Settings > Control Panel. The Control Panel appears. 

2 Tap Network and Dial Up and then the icon for your network 
connection (Ethernet or wireless). 

3 In the IP Address tab, select Obtain an IP Address via DHCP or 
Specify an IP Address. 

If you select Specify an IP Address, enter a valid IP address for the 
CV60, the subnet mask, and the default gateway. 

4 (Optional) On the Name Servers tab, enter the IP addresses for the 
primary and secondary DNS servers and for the primary and secondary 
WINS servers. 

5 Click OK. You are now ready to start the dcBrowser client. 

To start dcBrowser for the first time on the CV60 

1 Select Start > Programs > Intermec dcBrowser. A splash screen 
appears showing the dcBrowser title and version number. 

2 To set the IP and port number of the dcBrowser gateway, tap (Press 
Here for Setup).  

 

Note: If the dcBrowser client has not been configured with a valid IP 
address and port number, the IP configuration screen automatically 
appears. 

3 Press Enter to save your configuration. 
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Connecting to the dcBrowser Gateway 
After you have loaded and configured the dcBrowser client on your CV60, 
change the following parameters in the .INI file for the dcBrowser 
gateway. 

.INI File Parameters 

Parameter Change Value to 

INPUT_HIGHLIGHT INVERSE 

ANCHOR_HIGHLIGHT UNDERLINE 

SUBMIT_HIGHLIGHT UNDERLINE 

TAB_TO_SUBMIT TRUE 

TAB_TO_ANCHOR TRUE 

  

For the software only dcBrowser gateway, the .INI file is DCB.INI. For 
the dcBrowser on a DCS 30X or G4X00, the .INI file is WBS.INI. 

To change the .INI parameters 

1 Open the .INI file in a text editor such as Notepad. 

2 Change the parameters to the required values. 

3 Save the changes to the .INI file. 

4 Exit the text editor. 

You are now ready to start the dcBrowser client and connect to the 
gateway. 

To start the dcBrowser client on your CV60 

• Select Start > Programs > Intermec dcBrowser. 

Running the dcBrowser Client 

 

Note: You need to use the virtual keyboard or connect an external 
keyboard for the key sequences that include the Ctrl key. 

When you are running your HTML application, follow these guidelines: 

• Use the cursor keys, Tab key, or stylus to navigate from field to field.  

• Use the device’s scanner or keyboard to enter data. 

• Use auto-transmit fields to simplify data input. For help, see “Using 
Auto-Transmit Fields” on page 25. 

• Use the stylus to access the hypertext links or input buttons.  

• Press Ctrl-P to return to the home page. 
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These tables list special dcBrowser client key combinations that you may 
want to use while you are running your HTML application. 

The following table lists key combinations for either the virtual keyboard 
or an external keyboard. 

dcBrowser Client Key Combinations 

Virtual Keys Description 

Ctrl-C Clear screen 

Ctrl-N Ping the dcBrowser gateway 

Ctrl-T Toggle Timing mode 

Ctrl-W Refresh screen 

Ctrl-[ Increase volume 

Ctrl-{ Decrease volume 
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Troubleshooting 

 

This chapter describes solutions to some common problems. It also 
explains the diagnostics and how you can get help from Intermec Product 
Support. This chapter covers these topics: 

• Symptoms and solutions 

• Using the Product Support page 

 

10
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Symptoms and Solutions 
If you have problems running dcBrowser in your data collection network, 
look for your symptom in the table below, and then try the solutions in 
the order that they are listed. If your problem is not listed in the table, you 
can look at the diagnostics or refer to the Product Support web page. 

Symptoms and Solutions 

Symptom Solution 

From your device, you cannot 
connect to the DCS 30X or 
G4X00. 

View the current connections to be sure that you 
have a connection configured between the 
dcBrowser client and the dcBrowser gateway. Ping 
the DCS 30X or G4X00. 

Make sure that you have configured the network 
port on the device to 4055 for TCP/IP or 05555 
for UDP Plus. 

Make sure that you have correctly configured your 
RF network parameters on the device, access point, 
and DCS 30X or G4X00.  

On the DCS 30X, access the command prompt. 
Ping the device IP address. 

If you are using a UDP Plus or WTP terminal, 
check your configurations and correct if necessary. 

From your PC, you cannot 
connect to the DCS 30X or 
G4X00. 

You may access the Internet by using a proxy 
server. Make sure that you have added the 
DCS 30X or G4X00 IP address to your Exceptions 
list. 

After you reboot the DCS 30X, 
the response time between the 
device and the web server is 
slower than expected.  

You can continue to send data from the device. 
The network will speed up in about 30 minutes. 

Stop the dcBrowser gateway. Start the dcBrowser 
gateway and then turn on ONE device. When the 
device’s home page appears, then you can turn on 
the other devices. 

UDP Plus device continually 
reboots. 

Verify that dcBrowser gateway is running. 

Verify that the downline network is running. 

Verify that the device is configured in downline 
connections. 

Verify port number. 

The dcBrowser gateway starts 
and then stops. 

The dcBrowser gateway is already running as a 
service on the PC. Close one copy of the gateway. 
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Symptoms and Solutions (continued) 

Symptom Solution 

You start the dcBrowser client 
for the device and “Thin 
client for dcBrowser” is 
not replaced by the device’s web 
page. 

Use the PING command from the PC to verify 
that the device’s radio is configured properly. 

If you have a 6400, verify that the host IP address 
is correct in PSKNET.INI. 

Verify that the dcBrowser gateway is running. 

You start the dcBrowser client 
for the device and “Thin 
client for dcBrowser” is 
replaced by an error message. 

Verify that the web page is configured for the 
device. 

Verify that the DCS 30X is configured properly. 
After you change the DCS 30X configuration, 
you must save and reboot. For help, see the DCS 
30X online help. 

Verify that your web server is running. 

Verify that the host IP address has :80 at the end 
of it in the dcBrowser gateway configuration 
page. 

The scanner in the 6400 is not 
working. 

Verify that either 641223.EXE or 
64SCN7B.EXE started on reboot in your 
AUTOEXEC.BAT. Ensure 64SCN7A.EXE was 
run before N6400.EXE and after the above listed 
files. 

  

Using the Product Support Page 
The Product Support page provides many ways to get help: 

• Internet resources for linking to the Product Support home page for all 
Intermec products 

• Telephone numbers for contacting Product Support 

To access the Product Support page 

• From the home page for the DCS 30X or G4X00, click Support. The 
Product Support page appears. 
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Product Support Page 
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ASCII to Hex Conversion 

 

This appendix provides a table for converting ASCII characters to their 
hexadecimal values.  

 

A 
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ASCII to Hex Conversion 

Hex1 ASCII2 Hex1 ASCII2 

00 NUL 20 SP3 

01 SOH 21 ! 

02 STX 22 " 

03 ETX 23 # 

04 EOT 24 $ 

05 ENQ 25 % 

06 ACK 26 & 

07 BEL 27 ' 

08 BS 28 ( 

09 HT 29 ) 

0A LF 2A * 

0B VT 2B + 

0C FF 2C , 

0D CR 2D - 

0E SO 2E . 

0F SI 2F / 

10 DLE 30 0 

11 DC1 31 1 

12 DC2 32 2 

13 DC3 33 3 

14 DC4 34 4 

15 NAK 35 5 

16 SYN 36 6 

17 ETB 37 7 

18 CAN 38 8 

19 EM 39 9 

1A SUB 3A : 

1B ESC 3B ; 

1C FS 3C < 

1D GS 3D = 

1E RS 3E > 

1F US 3F ? 
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ASCII to Hex Conversion Table (continued) 

Hex1 ASCII2 Hex1 ASCII2 

40 @ 60 ` 

41 A 61 a 

42 B 62 b 

43 C 63 c 

44 D 64 d 

45 E 65 e 

46 F 66 f 

47 G 67 g 

48 H 68 h 

49 I 69 i 

4A J 6A j 

4B K 6B k 

4C L 6C l 

4D M 6D m 

4E N 6E n 

4F O 6F o 

50 P 70 p 

51 Q 71 q 

52 R 72 r 

53 S 73 s 

54 T 74 t 

55 U 75 u 

56 V 76 v 

57 W 77 w 

58 X 78 x 

59 Y 79 y 

5A Z 7A z 

5B [ 7B { 

5C \ 7C | 

5D ] 7D } 

5E ^ 7E ~ 

5F _   
    

1 This column lists the hexadecimal value. 

2 This column lists the ASCII character. 

3 SP is the SPACE character. 
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Symbols and Numbers  
1700 devices, See RT1700 devices 
2400 Menu System, 36 
502X Data Collection PC 

configuring TCP/IP, 51 
configuring UDP Plus on, 51 
continually reboots, 90 
dcBrowser client 

loading and configuring, 50 
running, 53 

HTML application, running, 53 
key combinations, 54 
Print tag, enabling, 52 
starting TCP/IP on, 51 
Unit Manager application, 50 
using M1 instead of F11 and M2 instead of F12, 34 

6400 devices 
configuring for your network, 58 
configuring host connection, 60 
dcBrowser client 

loading, 56 to 62 
required configurations, 56 
required files, 57 
running, 63 
starting, 62 
verifying that it is loaded, 56 

key combinations, 63 
PSKNET.INI, 60 
scanner not working, 91 
TFTP, setting up for, 58 

64SCN7A.EXE, 57 
700 Series Mobile Computer 

configuring TCP/IP, 72 
dcBrowser client, running, 73 
HTML application, running, 73 
IMDCB.INI, changing, 71 
installing dcBrowser client, 66 
key combinations, 74 
network timeout, 71 
starting TCP/IP dcBrowser client on, 72 
user interface lockdown, 70 
virtual keyboard, 70 

A 
ActiveSync 

changing settings on the 700, 68 
establishing a partnership with 700, 67 
establishing a partnership with CV60, 82 
exploring files on the 700, 67 
exploring files on the CV60, 83 
installing on 700, 67 
installing on CV60, 82 
reconnecting to 700, 69 
reconnecting to CV60, 84 

ActiveX, how dcBrowser supports, 9 
advanced features, 25 to 26 

auto-transmit fields, 25 
links, 25 

alt, attribute for Image tag, 15 
Anchor tag, 13 
anchor tags 

access using Tab key, 34 
checking for conflicts with input tags, 34 
displaying with F and function key number, 34 
displaying with special attributes, 33 

ANCHOR_HIGHLIGHT, 33 
application 

running, 31 
502X Data Collection PC, 53 
6400 devices, 63 
700 Series Mobile Computer, 73 
CK30, 78 
CV60, 87 
JANUS devices, 48 
Trakker Antares, 41 

sample, setting up, 31 
testing, 34 

ASCII to hex conversion, 94 
automatically launching client on CK30, 76 
auto-transmit fields, 25 

B 
batch file, JANUS example, 47 
baud=, attribute for Print tag, 20 
Beep tag, 14 
Bluetooth printing from CK30, 76 
border, attribute for Table tag, 21 
Break tag, 21 
buffered data, 25 

C 
calling previous screen, 34 
caption bar, removing on 700, 70 
caption bar, removing on CV60, 84 
CGI-BIN, 22 
changing device configuration, 32 
checking for conflicts in input and anchor tags, 34 
chgparms, 58 
ciperf, 33 
CK30 

Bluetooth printing, 76 
client on CK30 fails to connect to gateway, 78 
configuring, 77 
key combinations, 79 
loading and launching client, 76 
PRINTER_PORT registry key, 76 
running the dcBrowser client, 78 
System Main Menu, 76 
test and service mode, 76 
verifying the dcBrowser client is loaded, 76 

client 
502X 

installing, 50 
running, 53 
starting, 53 
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client (continued) 
6400 

loading, 56 to 62 
required configurations, 56 
required files, 57 
running, 63 
starting, 62 
verifing it is loaded, 56 

700 
installing, 66 
running, 73 
starting for first time, 72 

CK30 
configuring, 77 
loading and launching, 76 
running, 78 
verifying it is loaded, 76 

configuring 
502X Data Collection PC, 50 
CK30, 77 
JANUS devices, 44 
Trakker Antares, 38 

CV60 
installing, 82 
running, 87 
starting for first time, 86 

dcBrowser client CD, 29 
downloading new, 17 
font types for Trakker Antares, 39 
JANUS 

loading and configuring, 44 
running, 48 
starting, 48 

key combinations 
502X Data Collection PC, 54 
6400 devices, 63 
700 Series Mobile Computer, 74 
CK30, 79 
CV60, 88 
JANUS devices, 48 
Trakker Antares, 41 

loading 
502X Data Collection PC, 50 
6400 devices, 56 to 62 
700, 66 
CK30, 76 
CV60, 82 
JANUS devices, 44 
Trakker Antares, 36 

required configurations for 6400 devices, 56 
required files for 6400 devices, 57 
restarting, 17 
running 

502X Data Collection PC, 53 
6400 devices, 63 
700 Series Mobile Computer, 73 
CK30, 78 
CV60, 87 

client, running (continued) 
JANUS devices, 48 
Trakker Antares, 41 

starting 
6400 devices, 62 
JANUS devices, 48 
Trakker Antares, 40 

Trakker Antares 
configuring, 38 
running, 41 
starting, 40 
verifying it is loaded, 36 

troubleshooting, 91 
understanding, 3 
verifying it is loaded 

6400 devices, 56 
CK30, 76 
Trakker Antares, 36 

See also dcBrowser client 
COM port, setting on CK30, 76 
commands, HTML, See tags 
commands, sending Configuration commands to 

devices, 18 
CommonLogFormat, 33 
Configuration commands, sending to devices, 18 
configuring 

6400 devices for your network, 58 
CK30 computers, 77 
dcBrowser gateway, 32 
devices by serial number, 34 
font types for Trakker Antares, 39 
JANUS devices, 44 
RT1700 devices, 56 
software only gateway, 32 
TCP/IP on 502X, 51 
TCP/IP on 700, 72 
TCP/IP on CV60, 86 
test environment, 31 
Trakker Antares terminals, 38 

connecting to server, 700, 71 
connecting to server, CV60, 85 
connecting to the dcBrowser gateway 

502X Data Collection PC, 53 
6400 devices, 62 
700 Series Mobile Computer, 73 
CV60, 87 
JANUS devices, 48 
Trakker Antares terminals, 40 

connection delay for CK30 client, 78 
content=, attribute for Meta tag, 18 
cookies 

disabling return of, 33 
how dcBrowser supports, 9 
IM_DEVICE, 33 
IM_SERIAL, 34 
sending device serial number, 34 
serial data, returning, 18 

CURSOR attribute, 26 



Index 

100 Data Collection Browser Client User’s Guide 

cursor, attribute for Input tag, 16 
custom virtual keyboard on 700, 70 
CV60 

configuring TCP/IP, 86 
dcBrowser client, running, 87 
HTML application, running, 87 
IMDCB.INI, changing, 84 
installing dcBrowser client, 82 
key combinations, 88 
network, 85 
starting TCP/IP dcBrowser client on, 86 
user interface lockdown, 84 

D 
data 

returning screen, 19 
returning serial, 18 

data collection, enabling extensive performance, 33 
data=, attribute for Print tag, 20 
DCB.INI, configuring, 33 
DCB700.CAB, installing, 66 
DCBCK30.EXE, finding on computers, 76 
DCBCV60.CAB, installing, 82 
DCBJ24T.EXE 

loading, 44 
running, 48 

dcBrowser 
advanced features, 25 to 26 
advantages, 2 
learning about, 2 
thin client for, 62 
troubleshooting, 90 
understanding, 3 

dcBrowser client 
client on CK30 fails to connect to gateway, 78 
downloading new, 17 
restarting, 17 
symptoms and solutions, 90 
See also client 

dcBrowser gateway 
changing device configuration, 32 
configuring 

local gateway, 32 
RT1700 devices, 56 

for Windows NT, See software only gateway 
troubleshooting, 90 

DCBT24.BIN 
finding on terminals, 36 
loading, 37 
running, 40 

DCS 30X 
cannot connect, 90 
RT1700 devices with, 56 

delaying CK30 client connecting to gateway, 78 
device continually reboots, 90 
device ID, sending, 33 
Device Mapping Configuration screen, user ID, 

displaying on, 34 
device screen, page longer than, 33 

device serial number 
configuring devices by, 34 
sending, 34 

DHCP network, configuring devices by serial  
number, 34 

DIAG_AUTHORIZATION, 33 
DIAG_USER/DIAG_PASS, 33 
diagnostic screen, configuring access, 33 
directory 

CGI-BIN, 22 
DCBJ24T.EXE, 47 
DCBT24.BIN, 37 
FileCopy utility, 37 
HTML example, 22 
JANUS Image Manager utility, 44 
RFSIGN.HTM, 23 
tree, 30 

disabling 
configuration of gateway, 33 
return of cookies, 33 

dispatch scrolling log, 33 
DispatchLog, 33 
displaying input tags, 33 
down arrow key, pressing to get to top field, 33 
down=, attribute for Table tag, 21 
download=, attribute for Meta tag, 17 
downloading new dcBrowser client, 17 
dti_capture, attribute for Input tag, 16 
dti_strip, attribute for Input tag, 16 

E 
editing device configuration, 32 
ENABLE_SIP, 70 
Enter key, respond as standard Enter with links 

enabled, 34 
Enter key, when links disabled, 33 
ENTERKEY, 33 
environments 

runtime, setting up, 34 
software only gateway, 27 
test, setting up, 28 

Esc key, call previous screen, 34 
example 

Anchor tag, 13 
Beep tag, 14 
Headings tag, 15 
HTML code, 24 
Image tag, 15 
Input tag, 17 
JANUS batch file, 47 
Meta tag, using, 19 
Print tag, 21 
setting up example web pages, 22 
Table tag, 22 
web pages, illustrated, 23 

EXPAND_ROWS, 33 
extensive performance data collection, enabling, 33 
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F 
features 

advanced dcBrowser, 25 to 26 
auto-transmit fields, 25 
links, 25 

new, 4 
supported, HTML, 8 
unsupported, HTML, 9 

field that appears first, 26 
FIELD_WRAP, 33 
file directory, See directory 
File Manager, 50 
FileCopy utility 

directory, 37 
using to load dcBrowser client 

6400 devices, 60 
on Trakker Antares, 37 

FLAG_INPUT_TYPE, 33 
flagging input type, 33 
flow=, attribute for Print tag, 20 
font types for Trakker Antares, 39 
fonts, supported, 8 
full field, transmitting on, 26 
function key keyboard on 700, 70 
FUNCTION_KEY_SIP, 70 

G 
gateway 

502X, connecting, 53 
Anchor tag, using, 13 
configuring, 32 
connecting 

502X Data Collection PC, 53 
6400 devices, 62 
700 Series Mobile Computer, 73 
CV60, 87 
JANUS devices, 48 
Trakker Antares, 40 

Custom ID column, 17 
diagnostic screen, configuring access, 33 
disabling configuration, 33 
JANUS, connecting, 48 
Paragraph tag, interpreting, 20 
RT1700, using with, 56 
setting up, 28 
Trakker Antares, connecting, 40 
troubleshooting, 90 
understanding, 3 

getrelay, attribute for Meta tag, 19 
getsi, attribute for Meta tag, 19 
GUILockDown, 70, 84 

H 
Headings tag, 14 
hex to ASCII conversion, 94 
hidden field 

RELAY, 19 
SI, 19 

hidden, attribute for Input tag, 16 

host connection, configuring for 6400, 60 
href, attribute for Anchor tag, 13 
HTML 

3.2 tags, summary of, 10 to 12 
code 

example, 24 
viewing, 23 

special tags, 13 to 22 
Anchor, 13 
Beep, 14 
Headings, 14 
Image, 15 
Input, 16 
Meta, 17 
Paragraph, 19 
Print, 20 
Table, 21 

supported features, 8 
unsupported features, 9 

HTML application 
running 

502X Data Collection PC, 53 
6400 devices, 63 
700 Series Mobile Computer, 73 
CK30, 78 
CV60, 87 
JANUS devices, 48 
Trakker Antares, 40, 41 

testing, 34 
HTTP, 8 
http-equiv=, attribute for Meta tag, 18 

I 
ID, sending device, 33 
id=, attribute for Meta tag, 17 
IGNORE_ESCAPE, 34 
IM_DEVICE cookie, 33 
IM_SERIAL cookie, 34 
Image Manager utility, 44 
Image tag, 15 
IMDCB.INI 

502X Data Collection PC, 52 
6400, 57 
700 Series Mobile Computer, 70 
CV60, 84 
Trakker Antares, 39 
transmit on full, changing for, 26 

INI for gateway, configuring, 33 
INI parameters, changing, 53, 73, 87 
input fields, display with special attributes, 33 
Input tag 

configuring field that appears first, 26 
description, 16 

input tags 
checking for conflicts with anchor tags, 34 
displaying with F and function key number, 33 

input type, flagging, 33 
INPUT_HIGHLIGHT, 33 
int, attribute for Input tag, 16 
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IP address, turn on special screen, 34 
ITC64XFR.EXE, 57 
ITCLICPAKFILE, 33 

J 
JANUS devices 

configuring the dcBrowser client, 44 
connecting to the dcBrowser gateway, 48 
continually reboots, 90 
example batch file, 47 
Image Manager utility, 44 
key combinations, 48 
loading the dcBrowser client, 44 
running the dcBrowser client, 48 

Java, how dcBrowser supports, 9 
JavaScript, how dcBrowser supports, 9 
JScript, how dcBrowser supports, 9 

K 
key combinations 

502X Data Collection PC, 54 
6400 devices, 63 
700 Series Mobile Computer, 74 
CK30, 79 
CV60, 88 
JANUS devices, 48 
Trakker Antares, 41 

KEY_FLAG, 33 
key=, attribute for Anchor tag, 13 
key=, attribute for Input tag, 16 
keyboard data, adding flag, 33 

L 
launching client on CK30, 76 
license file, 27 
LICPAK.TXT, 33 
links 

checking for conflicts in input and anchor tags, 34 
disabled, 33 
Enter key respond as standard Enter key, 34 
on 502X, use M keys, 34 

links feature, 25 
loading 

dcBrowser client 
502X Data Collection PC, 50 
6400 devices, 56 to 62 
700, 66 
CK30, 76 
CV60, 82 
JANUS devices, 44 
Trakker Antares, 36 

the simulator, 29 
locking down the interface on the 700, 70 
locking down the interface on the CV60, 84 
logical names, turn on screen for, 34 
loopback test, 30 

M 
M keys, use instead of F11 and F12 on 502X, 34 
MAXLENGTH field, using, 16 
message=, attribute for Print tag, 20 
Meta tag, 17 

N 
NO_CONFIGURE, 33 
N6400.EXE 

described, 57 
finding on 6400, 56 
starting, 62 
transferring, 59 

network port, configuring for Trakker Antares, 38 
network timeout on 700, 71 
network timeout on CV60, 85 
new features, 4 
NO_ANCHOR_INDICATOR, 34 
NO_COOKIE, 33 
NO_INPUT_INDICATOR, 33 
noscan, attribute for Input tag, 16 

O 
opening a screen after a delay, 18 
optical isolator input, sending, 19 
ORDER_LINK, 34 

P 
page longer than device screen, 33 
Pak file, locating, 33 
Paragraph tag, 19 
parity=, attribute for Print tag, 20 
password, attribute for Input tag, 16 
performance data collection, enabling extensive, 33 
plug-ins, how dcBrowser supports, 9 
POST_RADIOID, 33 
POST_SERIAL_NUM, 34 
previous screen, calling, 34 
Print tag, 20 
PRINTER_PORT registry key, CK30, 76 
printing from CK30, 76 
printing, enabling on 502X, 52 
problems running dcBrowser, 90 
PSKNET.INI 

changing, 60 
described, 57 
finding on 6400, 56 
transferring, 59 

R 
reader_cmd, attribute for Meta tag, 18 
reboot, attribute for Meta tag, 17 
reconnecting ActiveSync to 700, 69 
reconnecting ActiveSync to CV60, 84 
registry key, printing from CK30, 76 
relay, attribute for Meta tag, 18 
repeat=, attribute for Beep tag, 14 
reset, attribute for Input tag, 16 
response time is slow, 90 
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restarting the dcBrowser client, 17 
retonsi, attribute for Meta tag, 19 
returning serial data, 18 
returnserial, attribute for Meta tag, 18 
RFSIGN.HTM, 24 
RL2PCM.COM, 57 
RT1700 devices 

configuring, 56 
dcBrowser gateway, using with, 56 

running 
dcBrowser client 

502X Data Collection PC, 53 
6400 devices, 63 
700 Series Mobile Computer, 73 
CK30, 78 
CV60, 87 
JANUS devices, 48 
Trakker Antares, 41 

your application, 31 
runtime environment, setting up, 34 

S 
sample application, setting up, 31 
SCAN_FLAG, 33 
scan-ahead, 25 
scanned data, adding flag, 33 
scanner input, screen transmitted, 34 
scanonly, attribute for Input tag, 16 
screen data, returning, 19 
screen size, changing, 31 
screen, opening after delay, 18 
scrollable=, attribute for Table tag, 21 
scrolling log 

CommonLogFormat, 33 
dispatch, 33 

serial data, returning, 18 
serial number 

configuring devices by, 34 
sending device, 34 

SERIAL_NO_CONFIGURE, 34 
SERIN cookie, 18 
setting the network configuration, 6400, 58 
setting up 

runtime environment, 34 
sample application, 31 
software only gateway environment, 28 
test environment, 28 

setup screen link 
700, 70 

SETUP.EXE, 50 
SHOW_USERID, 34 
SI, hidden field, 19 
simulator 

changing the screen size, 31 
connecting to a different PC, 30 
described, 22 
loading, 29 
running multiple copies of, 30 

SIP, 70 

soft keyboard on 700, 70 
software only gateway 

configuring, 32 
environment, 27 
requirements, 28 
setting up the environment, 28 

standard virtual keyboard on 700, 70 
Start menu, controlling access on 700, 70 
Start menu, controlling access on CV60, 84 
starting 

502X, dcBrowser client on, 53 
6400 devices, dcBrowser client on, 62 
700, dcBrowser client on, 72, 73 
CV60, dcBrowser client on, 87 
JANUS devices, dcBrowser client on, 48 
TCP/IP dcBrowser client on 700, 72 
TCP/IP dcBrowser client on CV60, 86 
TCP/IP on 502X, 51 
Trakker Antares terminals, dcBrowser client on, 40 

stdout, displaying, 33 
stop=, attribute for Print tag, 20 
submit buttons 

accessing using Tab key, 34 
displaying with special attributes, 34 
select using Enter key, 34 

submit, attribute for Input tag, 16 
SUBMIT_HIGHLIGHT, 34 
syntax, HTML, 8 
system input 

returning screen data, 19 
sending, 19 

System Main Menu, CK30, 76 

T 
Tab key, pressing to get to top field, 33 
TAB_TO_ANCHOR, 34 
TAB_TO_SUBMIT, 34 
Table tag, 21 
tags 

how dcBrowser supports, 9 
HTML 3.2, summary of, 10 to 12 
special, 13 to 22 

TCP/IP 
configuring 502X, 51 
configuring 700, 72 
configuring CV60, 86 
starting dcBrowser client on 700, 72 
starting dcBrowser client on CV60, 86 
starting on 502X, 51 

test and service mode, 36, 76 
test environment 

configuring, 31 
requirements, 28 
setting up, 28 

testing your application, 34 
text, attribute for Input tag, 16 
TFTP, transferring files to 6400, 58 
thin client for dcBrowser, 62, 91 
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timeout 
700, network, 71 
CV60, network, 85 

timeout for serial port input, 20 
timeout=, attribute for Print tag, 20 
Trakker Antares 

2400 Menu System, 36 
configuring, 38 
continually reboots, 90 
fonts, displaying different, 39 
key combinations, 41 
loading the dcBrowser client, 36 
network port, configuring, 38 
running the dcBrowser client, 41 
starting the dcBrowser client, 40 
test and service mode, 36 
verifying the dcBrowser client is loaded, 36 

transferring files to 6400 devices 
FileCopy utility, 60 
TFTP, 58 

transmit screen upon scanner input, 34 
transmit, attribute for Input tag, 16 
TRANSMIT_ON_FULL, 26 
TRANSMIT_ON_RETURN, 34 
TRANSMIT_ON_SCAN, 34 
transmitting on full field, 26 
troubleshooting 

dcBrowser client and gateway, 90 
client on CK30 fails to connect to gateway, 78 

type-ahead, 25 

U 
UDP Plus device continually reboots, 90 
UDP Plus, configuring 502X, 51 
UDP_WTP_ALLOWED, 34 
Unit Manager application, 50 
up=, attribute for Table tag, 21 
USE_M_KEYS, 34 
user ID, displaying on Device Mapping Configuration 

screen, 34 
user interface lockdown on 700, 70 
user interface lockdown on CV60, 84 

V 
verifying the dcBrowser client is loaded 

6400 devices, 56 
CK30, 76 
Trakker Antares, 36 

viewing HTML code, 23 
virtual keyboard, button visible on 700, 70 
visible(stdout), 33 

W 
wait=, attribute for Print tag, 20 
web page 

example, 22 
sample, setting up, 22, 31 
viewing code, 23 

what’s new, 4 
window size, changing, 31 
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